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Safety warning notice

Å
WARNING: To reduce the possibility of heat-related injuries or of 
overheating the computer, do not place the computer directly on your 
lap or obstruct the computer air vents. Use the computer only on a hard, 
flat surface. Do not allow another hard surface, such as an adjoining 
optional printer, or a soft surface, such as pillows or rugs or clothing, to 
block airflow. Also, do not allow the AC adapter to contact the skin or 
a soft surface, such as pillows or rugs or clothing, during operation. The 
computer and the AC adapter complies with the user-accessible surface 
temperature limits defined by the International Standard for Safety of 
Information Technology Equipment (IEC 60950).
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1
Product Description

The HP Compaq nc6400 Notebook PC offers advanced 
modularity, Intel® Core™ Duo, Core Solo, and Celeron® 
processors, and extensive multimedia support.

HP Compaq nc6400 Notebook PC
Maintenance and Service Guide 1�1



Product Description
1.1 Features
■ The following processors, varying by computer model:

❏ Intel Core Duo T7600 (2.33-GHz) processor

❏ Intel Core Duo T7400 (2.16-GHz) processor

❏ Intel Core Duo T7200 (2.00-GHz) processor

❏ Intel Core Duo T5600 (1.83-GHz) processor

❏ Intel Core Duo T5500 (1.66-GHz) processor

❏ Intel Core Duo T2300E (1.66-GHz) processor

❏ Intel Core Duo T2600 (2.17-GHz) processor

❏ Intel Core Duo T2500 (2.00-GHz) processor

❏ Intel Core Duo T2400 (1.83-GHz) processor

❏ Intel Core Duo T2300 (1.67-GHz) processor

❏ Intel Core Solo T1300 (1.66-GHz) processor

❏ Intel Celeron M 440 (1.80-GHz) processor

❏ Intel Celeron M 430 (1.73-GHz) processor

■ 14.1-inch, WXGA+, TFT (1440 × 900) and 14.1-inch, 
WXGA, TFT (1440 × 900) display, with over 16.8 million 
colors, varying by computer model

■ 120-, 100-, 80-, 60-, and 40-GB high-capacity hard drive, 
varying by computer model

■ 256-MB DDR2 synchronous DRAM (SDRAM) at 533 MHz 
and 667 MHz, expandable to 4.0 GB

■ Microsoft® Windows Vista™ Business, Windows Vista 
Home Basic, and Windows® XP Professional

■ Full-size Windows keyboard with numeric keypad

■ TouchPad and pointing stick pointing devices, including a 
dedicated vertical scroll region

■ Integrated 10 Base-T/100 Base-TX Ethernet local area 
network (LAN) network interface card (NIC) with RJ-45 jack
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Product Description
■ Integrated high-speed 56K modem with RJ-11 jack

■ Integrated wireless support for Mini Card IEEE 802.11a/b/g 
or 802.11b/g Wireless LAN (WLAN) device

■ Support for one Type I or Type II PC Card slot, with support 
for both 32-bit (CardBus) and 16-bit PC Cards, varying by 
computer model

■ External 90- and 65-watt AC adapters with 3-wire power 
cord, varying by computer model

■ 8-cell and 4-cell Li-Ion batteries

■ Stereo speakers

■ Volume up, volume mute, and volume down buttons

■ Support for the following optical drives:

❏ DVD±RW and CD-RW Double-Layer Combo Drive
❏ DVD±RW and CD-RW Combo Drive
❏ DVD-ROM drive

■ Connectors:

❏ Accessory battery

❏ Audio-in (microphone)

❏ Audio-out (headphone)

❏ Digital Media Slot

❏ Docking connector

❏ External monitor

❏ IEEE 1394

❏ RJ-11 (modem)

❏ RJ-45 (network)

❏ S-Video-out

❏ SmartPower

❏ Three Universal Serial Bus (USB) v. 2.0
Maintenance and Service Guide 1�3



Product Description
1.2 Resetting the Computer
If the computer you are servicing has an unknown password, 
follow the steps below to reset the password. These steps also 
clear CMOS.

✎ The following steps will not clear an unknown password if the 
stringent security option has been enabled in the BIOS. If 
stringent security is enabled, the system board must be replaced 
to reset an unknown password. Refer to Section 5.21, “Top 
Cover,” for more information on replacing the system board.

Before replacing the system board, perform the steps below to 
make sure stringent security has been properly enabled.

Enabling stringent security provides enhanced protection for the 
power-on password and administrator password and other forms 
of power-on authorization. Stringent security is enabled/disabled 
by accessing the Password Options menu in the Computer Setup 
utility.

1. Prepare the computer for disassembly (refer to Section 5.3, 
“Preparing the Computer for Disassembly,” for more 
information).

2. Remove the real-time clock (RTC) battery (refer to
Section 5.11, “RTC Battery,” for more information on 
removing and replacing the RTC battery).

3. Wait approximately 5 minutes.

4. Replace the RTC battery and reassemble the computer.

5. Connect AC power to the computer. Do not reinsert any 
batteries at this time.

6. Turn on the computer.

All passwords and all CMOS settings have been cleared.
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1.3 Power Management
The computer comes with power management features that 
extend battery operating time and conserve power. The 
computer supports the following power management features:

■ Standby

■ Hibernation

■ Setting customization by the user

■ Hotkeys for setting the level of performance

■ Battery calibration

■ Lid switch standby/resume

■ Power button

■ Advanced Configuration and Power Management (ACPM) 
compliance
Maintenance and Service Guide 1�5
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1.4 External Components
The external components on the front of the computer are shown 
below and described in Table 1-1.

Front Components

Table 1-1

Front Components

Item Component Function

1 Wireless light On: An integrated wireless device, such as 
a wireless local area network (LAN) device 
and/or a Bluetooth® device, is turned on.

2 Power light ■ On: The computer is on.

■ Blinking: The computer is in standby.

■ Blinking rapidly: An HP Smart AC 
Adapter with a higher power rating 
should be connected.

■ Off: The computer is off or in hibernation.
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3 Battery light ■ Amber: A battery is charging.

■ Green: A battery is close to full charge 
capacity.

■ Blinking amber: A battery that is the only 
available power source has reached a 
low-battery condition. When the battery 
reaches a critical low-battery condition, 
the battery light begins blinking more 
quickly.

■ Off: If the computer is connected to an 
external power source, the light is turned 
off when all batteries in the computer are 
fully charged. If the computer is not 
connected to an external power source, 
the light is turned off until the battery 
reaches a low-battery condition.

4 Drive light ■ Blinking green: The hard drive or optical 
drive is being accessed.

■ Amber: HP Mobile Data Protection has 
temporarily parked the hard drive.

5 Infrared port Provides wireless communication between 
the computer and an optional 
IrDA-compliant device.

6 Digital Media Slot Supports Secure Digital (SD) Memory 
Cards and MultiMediaCards (MMC).

7 Stereo speakers (2) Produce stereo sound.

8 Display release latch Opens the computer.

Table 1-1

Front Components (Continued)

Item Component Function
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The external components on the right side of the computer are 
shown below and described in Table 1-2.

Right-Side Components
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Table 1-2

Right-Side Components

Item Component Function

1 Smart card slot Supports optional smart cards and Java™ 
Cards.

2 MultiBay II device Supports an optical disc. The type of optical 
drive varies by computer model.

3 USB port Connects USB 1.1- and 2.0-compliant 
devices to the computer using a standard 
USB cable, or connects an optional 
External MultiBay II to the computer. The 
MultiBay II must also be connected to an 
external power source.

4 RJ-45 (network) jack Connects an optional network cable.

5 RJ-11 (modem) jack Connects the modem cable.
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The external components on the left side of the computer are 
shown below and described in Table 1-3.

Left-Side Components
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Table 1-3

Left-Side Components

Item Component Function

1 Exhaust vent Provides airflow to cool internal 
components.

2 USB ports (2) Connect USB 1.1- and 2.0-compliant 
devices to the computer using a standard 
USB cable, or connect an optional External 
MultiBay II to the computer. The MultiBay II 
must also be connected to an external 
power source.

3 Audio-in 
(microphone) jack

Connects an optional computer headset 
microphone, stereo array microphone, or 
monaural microphone.

4 Audio-out 
(headphone) jack

Produces computer sound when connected 
to optional power stereo speakers, 
headphones, ear buds, a headset, or 
television audio.

5 PC Card slot Supports optional Type I or Type II 32-bit 
(CardBus) or 16-bit PC Cards.
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The external components on the rear panel of the computer are 
shown below and described in Table 1-4.

Rear Panel Components
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Table 1-4

Rear Panel Components

Item Component Function

1 Security cable slot Attaches an optional security cable to the 
computer.

Ä Security solutions are designed to 
act as deterrents. These deterrents 
may not prevent a product from 
being mishandled or stolen.

2 Battery bay Holds a battery.

3 Smart adapter power 
connector

Connects an AC adapter or an optional 
power adapter.

4 S-Video-out jack Connects an optional S-Video device, 
such as a television, VCR, camcorder, 
projector, or video capture card.

5 External monitor port Connects an optional VGA external 
monitor or projector.
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The standard keyboard components of the computer are shown 
below and described in Table 1-5.

Standard Keyboard Components
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Table 1-5

Standard Keyboard Components

Item Component Function

1 fn key Executes frequently used system 
functions when pressed in combination 
with a function key or the esc key.

2 caps lock key Enables caps lock and turns on the caps 
lock light.

3 f1 to f12 keys (12) Perform system and application tasks. 
When combined with the fn key, several 
keys and buttons perform additional tasks 
as hotkeys.

4 num lock key Enables numeric lock, turns on the 
embedded numeric keypad, and turns 
on the num lock light.

5 Embedded keypad In Windows, can be used like the keys 
on an external numeric keypad.

6 Arrow keys Moves the cursor around the screen.

7 Windows 
applications key

In Windows, displays a shortcut menu 
for items beneath the pointer.

8 Windows logo key In Windows, displays the Windows 
Start menu.
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The computer top components are shown below and described in 
Table 1-6.

Top Components
1�16 Maintenance and Service Guide



Product Description
Table 1-6

Top Components

Item Component Function

1 Power button When the computer is:

■ Off, press to turn on the computer.

■ On, briefly press to initiate hibernation.

■ In standby, briefly press to resume from 
standby.

■ In hibernation, briefly press to restore 
from hibernation.

If the system has stopped responding and 
Windows shutdown procedures cannot be 
used, press and hold for 5 seconds to turn 
off the computer.

2 Info Center button Launches Info Center, which enables you 
to open various software solutions.

3 Wireless button Turns the wireless functionality on or off, 
but does not create a wireless connection.

✎ To establish a wireless connection, 
a wireless network must already be 
set up.

4 Presentation button Turns on the presentation feature.

5 Volume mute button Mutes or restores speaker volume.

6 Volume down button Decreases speaker volume.

7 Volume up button Increases speaker volume.
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The computer top components are shown below and described in 
Table 1-7.

Top Components
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Table 1-7

Top Components

Item Component Function

1 Power light ■ On: The computer is on.

■ Blinking: The computer is in standby.

■ Blinking rapidly: An AC adapter with a 
higher power rating should be 
connected.

■ Off: The computer is off or in 
hibernation.

2 Wireless light On: An integrated wireless device, such as 
a wireless local area network (LAN) device 
and/or a Bluetooth® device, is turned on.

3 Caps lock light On: caps lock is on.

4 Num lock light On: num lock or the numeric keypad is on.

5 Fingerprint reader Allows a fingerprint logon to Windows 
instead of using a password.
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The computer pointing device components are shown below and 
described in Table 1-8.

Pointing Device Components
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Table 1-8

Pointing Device Components

Item Component Function

1 Pointing stick Moves the pointer and selects or activates 
items on the screen.

2 Pointing stick buttons Function like the left, middle, and right 
buttons on an external mouse.

3 TouchPad Moves the pointer and selects or activates 
items on the screen. Can be set to perform 
other mouse functions, such as scrolling, 
selecting, and double-clicking.

4 TouchPad buttons Function like the left, middle, and right 
buttons on an external mouse.

5 TouchPad scroll zone Scrolls up or down.
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The external components on the bottom of the computer are 
shown below and described in Table 1-9.

Bottom Components

Table 1-9

Bottom Components

Item Component Function

1 Battery bay Holds the battery.

2 Docking connector 
(full-featured models only)

Connects the computer to an optional 
docking device.

3 Battery release latches (2) Release the battery from the battery 
bay.

4 Accessory battery 
connector

Connects an optional HP Ultra-Capacity 
Battery or HP Extended Life Battery.
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5 Exhaust vents Provides airflow to cool internal 
components.

6 Hard drive bay Holds the primary hard drive.

7 Memory module 
compartment

Contains one memory slot that supports 
replaceable memory modules.

8 Bluetooth compartment Contains a Bluetooth device (select 
computer models only).

9 Serial number Identifies the computer. This number is 
needed when contacting customer 
support.

10 Mini Card compartment Holds an optional wireless LAN device.

Ä To prevent an unresponsive 
system and the display of a 
warning message, install only a 
Mini Card device authorized for 
use in your computer by the 
governmental agency that 
regulates wireless devices in 
your country or region. If you 
install a device and then receive 
a warning message, remove 
the device to restore computer 
functionality. Then contact 
technical support by selecting 
Start > Help and Support > 
Contact support.

Table 1-9

Bottom Components (Continued)

Item Component Function
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1.5 Design Overview
This section presents a design overview of key parts and features 
of the computer. Refer to Chapter 3, “Illustrated Parts Catalog,” 
to identify replacement parts, and Chapter 5, “Removal and 
Replacement Procedures,” for disassembly steps.

The system board provides the following device connections:

■ Audio

■ Display

■ Hard drive

■ Intel Core Duo, Core Solo, and Celeron processors

■ Keyboard and TouchPad

■ Memory modules

■ Mini Card module

■ PC Card

Ä
CAUTION: To properly ventilate the computer, allow at least a 7.6-cm 
(3-inch) clearance on the left and right sides of the computer.

The computer uses an electric fan for ventilation. The fan is 
controlled by a temperature sensor and is designed to turn on 
automatically when high temperature conditions exist. These 
conditions are affected by high external temperatures, system 
power consumption, power management/battery conservation 
configurations, battery fast charging, and software. Exhaust air 
is displaced through the ventilation grill located on the left side 
of the computer.
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2
Troubleshooting

Å
WARNING: Only authorized technicians trained by HP should repair 
this equipment. All troubleshooting and repair procedures are detailed 
to allow only subassembly-/module-level repair. Because of the 
complexity of the individual boards and subassemblies, do not attempt 
to make repairs at the component level or modifications to any printed 
wiring board. Improper repairs can create a safety hazard. Any 
indication of component replacement or printed wiring board 
modification may void any warranty or exchange allowances.

2.1 Starting Computer Setup
Computer Setup is a preinstalled, ROM-based utility that can be 
used even when the operating system is not working or will not 
load.

✎ Some of the Computer Setup menu items listed in this guide 
may not be supported by your computer.

✎ Pointing devices are not supported in Computer Setup. You 
must use the keyboard to navigate and make selections.

✎ An external keyboard connected by USB can be used with 
Computer Setup only if USB legacy support is enabled.
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Troubleshooting
To start Computer Setup:

1. Turn on or restart the computer.

2. Before Windows® opens and while the “F10=ROM Based 
Setup” message is displayed in the lower-left corner of the 
screen, press f10.

Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed 
from the File, Security, Diagnostics, and System Configuration 
menus.

1. Open Computer Setup by turning on or restarting the 
computer, and then pressing f10 while the “F10 = ROM 
Based Setup” message is displayed in the lower-left corner of 
the screen.

Because Computer Setup is not Windows-based, it does not 
support the TouchPad. Navigation and selection are by 
keystroke:

❏ To choose a menu or a menu item, use the arrow keys.

❏ To select an item, press enter.

❏ To close open dialog boxes and return to the main 
Computer Setup screen, press esc.

❏ To view navigation information, press f1.

❏ To change the language, press f2.

2. Select the File, Security, Diagnostics, or System 
Configuration menu.
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3. To exit Computer Setup, choose one of the following 
methods:

❏ To exit Computer Setup without saving your preferences, 
use the arrow keys to select File > Ignore Changes and 
Exit. Then follow the instructions on the screen.

❏ To save your preferences and exit Computer Setup, use the 
arrow keys to select File > Save Changes and Exit. Then 
follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

Restoring Factory Settings in Computer 
Setup

To return all settings in Computer Setup to the values that were 
set at the factory, follow these steps:

1. Open Computer Setup by turning on or restarting the 
computer, and then pressing f10 while the “F10 = ROM 
Based Setup” message is displayed in the lower-left corner of 
the screen.

2. Use the arrow keys to select File > Restore defaults, and 
then press enter.

3. When the confirmation dialog box opens, press f10.

4. To save your preferences and exit Computer Setup, use the 
arrow keys to select File > Save Changes and Exit. Then 
follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

✎ Your password settings and security settings are not changed 
when you restore the factory settings.
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Computer Setup Menus
The menu tables in this section provide an overview of Computer 
Setup options.

✎ Some of the Computer Setup menu items listed in this chapter 
may not be supported by your computer.

File Menu

Table 2-1

File Menu

Select To do this

System Information ■ View identification information for the computer 
and the batteries in the system.

■ View specification information for the processor, 
cache and memory size, system ROM, video 
revision, and keyboard controller version.

Restore defaults Replace the configuration settings in Computer Setup 
with the original factory settings. (Password settings 
and security settings are not changed when you 
restore the factory settings.)

Ignore changes and exit Cancel any changes entered during the current 
session. Then exit and restart the computer.

Save changes and exit Save any changes entered during the current 
session. Then exit and restart the computer. Your 
changes go into effect when the computer restarts.
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Security Menu

Table 2-2

Security Menu

Select To do this

Setup password Enter, change, or delete a setup password.

Power-On password Enter, change, or delete a power-on password.

Password options ■ Enable/disable stringent security.

■ Enable/disable password requirement on computer 
restart.

DriveLock passwords ■ Enable/disable DriveLock on any computer hard 
drive and on optional MultiBay hard drives.

■ Change a DriveLock user password or master 
password.

✎ DriveLock settings are accessible only when 
you enter Computer Setup by turning on (not 
restarting) the computer.

Smart Card security Enable/disable support for smart card and Java™ 
Card power-on authentication.

✎ Power-on authentication for smart cards is 
supported only on computers with optional 
smart card readers.

✎ You must have an administrator password to 
change this setting.
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Troubleshooting
TPM Embedded 
Security

Enable/disable support for TPM (Trusted Platform 
Module) Embedded Security, which protects the 
computer from unauthorized access to owner 
functions available in Embedded Security for 
ProtectTools. For more information, refer to the 
ProtectTools online Help.

✎ You must have a setup password to change 
this setting.

System IDs Enter user-defined computer asset and ownership 
tag.

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the 
primary hard drive. The following options are 
available:

■ Fast: Runs the Disk Sanitizer erase cycle once.

■ Optimum: Runs the Disk Sanitizer erase cycle 3 
times.

■ Custom: Allows you to select the desired number 
of Disk Sanitizer erase cycles from a list.

Ä If you run Disk Sanitizer, the data on the 
primary hard drive is destroyed permanently.

Table 2-2

Security Menu (Continued)

Select To do this
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Troubleshooting
Diagnostics Menu

System Configuration Menu

✎ Some of the listed System Configuration options may not be 
supported by your computer.

Table 2-3

Diagnostics Menu

Select To do this

Hard Drive Self-Test 
options

Run a comprehensive self-test on any hard drive in 
the system or on any optional MultiBay hard drive.

Memory Check Run a comprehensive check on system memory.

Startup Check (select 
models only)

Verify the system components needed for starting the
computer.

Table 2-4

System Configuration Menu

Select To do this

Language (or press f2) Change the Computer Setup language.

Boot options ■ Set f9, f10, and f12 delay when starting up.

■ Enable/disable CD-ROM boot.

■ Enable/disable floppy boot.

■ Enable/disable internal network adapter boot and 
set the boot mode (PXE or RPL).

■ Enable/disable MultiBoot, which sets a boot order 
that can include most boot devices in the system.

■ Set the Express Boot Popup delay in seconds.

■ Set the boot order.
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Troubleshooting
Table 2-4

System Configuration Menu (Continued)

Select To do this

Device Configurations ■ Swap the functions of the fn key and left ctrl key.

■ Enable/disable multiple standard pointing devices 
at startup. (To set the computer to support only a 
single, usually nonstandard, pointing device at 
startup, select Disable.)

■ Enable/disable USB legacy support. When 
enabled, USB legacy support allows the following:

❐ Use of a USB keyboard, mouse, and hub in 
Computer Setup even when a Windows 
operating system is not running.

❐ Startup from bootable USB devices, including 
a hard drive, diskette drive, or optical drive 
connected by a USB port to the computer or 
to an optional docking device (select models 
only).

■ Select a parallel port mode: EPP (Enhanced 
Parallel Port), standard, bidirectional, or ECP 
(Enhanced Capabilities Port).

■ Enable/disable BIOS DMA data transfers.

■ Enable/disable fan always on while connected to 
an AC outlet.

■ Enable/disable Intel® Data Execution Prevention 
or AMD® PSAE Execution Disable. When enabled, 
the processor can disable some virus code 
execution, which helps to improve computer 
security.

■ Enable/disable LAN Power Save. When enabled, 
saves power by turning off the LAN when not in 
use.

■ Enable/disable SATA Native Mode.

■ Enable/disable Dual Core CPU.

■ Enable/disable Secondary Battery Fast Charge.
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Troubleshooting
Device configurations 
(continued)

■ Choose Bit-shift or LBA assisted HDD Translation 
Mode.

■ Enable/disable Windows direct application 
launcher.

■ Enable/disable HP Lockout.

Built-In Device Options ■ Enable/disable embedded WWAN Device Radio.

■ Enable/disable embedded WLAN Device Radio

■ Enable/disable embedded Bluetooth® Device 
Radio.

■ Enable/disable LAN/WLAN Switching. When 
enabled, switches to a WLAN when a LAN is 
either unavailable or disconnected.

■ Enable/disable Wake on LAN from Off.

■ Enable/disable the ambient light sensor.

Port Options ■ Enable/disable the serial port.

■ Enable/disable the parallel port.

■ Enable/disable the flash media reader.

■ Enable/disable the USB port.

Ä Disabling the USB port also disables MultiBay 
devices and ExpressCard devices on the 
advanced port replicator.

■ Enable/disable the 1394 port.

■ Enable/disable the cardbus slot.

■ Enable/disable the ExpressCard slot.

■ Enable/disable the infrared port.

■ Enable/disable the optical disk drive.

■ Enable/disable the network controller.

Table 2-4

System Configuration Menu (Continued)

Select To do this
Maintenance and Service Guide 2�9



Troubleshooting
2.2 Troubleshooting Flowcharts

Table 2-5

Troubleshooting Flowcharts Overview

Flowchart Description

2.1 “Flowchart 2.1—Initial Troubleshooting”

2.2 “Flowchart 2.2—No Power, Part 1”

2.3 “Flowchart 2.3—No Power, Part 2”

2.4 “Flowchart 2.4—No Power, Part 3”

2.5 “Flowchart 2.5—No Power, Part 4”

2.6 “Flowchart 2.6—No Video, Part 1”

2.7 “Flowchart 2.7—No Video, Part 2”

2.8 “Flowchart 2.8—Nonfunctioning Docking Device (if applicable)”

2.9 “Flowchart 2.9—No Operating System (OS) Loading”

2.10 “Flowchart 2.10—No OS Loading, Hard Drive, Part 1”

2.11 “Flowchart 2.11—No OS Loading, Hard Drive, Part 2”

2.12 “Flowchart 2.12—No OS Loading, Hard Drive, Part 3”

2.13 “Flowchart 2.13—No OS Loading, Diskette Drive”

2.14 “Flowchart 2.14—No OS Loading, Optical Drive”

2.15 “Flowchart 2.15—No Audio, Part 1”

2.16 “Flowchart 2.16—No Audio, Part 2”

2.17 “Flowchart 2.17—Nonfunctioning Device”

2.18 “Flowchart 2.18—Nonfunctioning Keyboard”

2.19 “Flowchart 2.19—Nonfunctioning Pointing Device”

2.20 “Flowchart 2.20—No Network/Modem Connection”
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Troubleshooting
Flowchart 2.1�Initial Troubleshooting
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Troubleshooting
Flowchart 2.2�No Power, Part 1
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Troubleshooting
Flowchart 2.3�No Power, Part 2
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Troubleshooting
Flowchart 2.4�No Power, Part 3
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Troubleshooting
Flowchart 2.5�No Power, Part 4
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Troubleshooting
Flowchart 2.6�No Video, Part 1
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Troubleshooting
Flowchart 2.7�No Video, Part 2
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Troubleshooting
Flowchart 2.8�Nonfunctioning Docking Device
(if applicable)

Y

N

Reset power cord in 
docking device and

power outlet.

N

Test replacement 
docking device with 

new computer.

Check voltage
setting on docking 

device.

Reset monitor
cable connector at

docking device.

Reinstall
computer into 

docking device.

Docking 
device

operating?

Docking 
device

operating?

Replace docking 
device.

Done Done

Y

Nonfunctioning
docking device.
2�18 Maintenance and Service Guide



Troubleshooting
Flowchart 2.9�No Operating System (OS) 
Loading
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Troubleshooting
Flowchart 2.10�No OS Loading, Hard Drive, 
Part 1
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Flowchart 2.11�No OS Loading, Hard Drive, 
Part 2
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Troubleshooting
Flowchart 2.12�No OS Loading, Hard Drive, 
Part 3
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Troubleshooting
Flowchart 2.13�No OS Loading, Diskette Drive
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Troubleshooting
Flowchart 2.14�No OS Loading, Optical Drive
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Flowchart 2.15�No Audio, Part 1
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Flowchart 2.16�No Audio, Part 2
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Flowchart 2.17�Nonfunctioning Device
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Flowchart 2.18�Nonfunctioning Keyboard
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Flowchart 2.19�Nonfunctioning Pointing Device
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Flowchart 2.20�No Network/Modem 
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3
Illustrated Parts Catalog

This chapter provides an illustrated parts breakdown and a 
reference for spare part numbers.

3.1 Serial Number Location
When ordering parts or requesting information, provide the 
computer serial number and computer model number located on 
the bottom of the computer.

Serial Number Location
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3.2 Computer Major Components

Computer Major Components
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Illustrated Parts Catalog
Table 3-1

Spare Parts: Computer Major Components

Item Description
Spare Part 
Number

1 Display assemblies (include wireless antenna transceivers 
and cables)

14.1-inch, WXGA+
14.1-inch, WXGA

418907-001
418896-001

Refer to Section 3.3, “Display Assembly Components,” for display 
assembly internal component spare part number information.

2 Switch cover 418900-001

3 Power button board (includes power button board 
cable)

418908-001

4 Keyboards
For use in:

Belgium
Brazil
The Czech 

Republic
Denmark
France
French Canada
Germany
Greece
Hungary
Iceland
Internationally
Israel
Italy
Japan
Korea

418910-A41
418910-201
418910-221

418910-081
418910-051
418910-121
418910-041
418910-151
418910-211
418910-DD1
418910-021
418910-BB1
418910-061
418910-291
418910-AD1

Latin America
Norway
Portugal
Russia
Saudi Arabia
Slovakia
Slovenia
Spain
Sweden/Finland
Switzerland
Taiwan
Thailand
Turkey
The United 

Kingdom
The United 

States

418910-161
418910-091
418910-131
418910-251
418910-171
418910-231
418910-BA1
418910-071
418910-101
418910-111
418910-AB1
418910-281
418910-141
418910-031

418910-001
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Illustrated Parts Catalog
Table 3-1

Spare Parts: Computer Major Components (Continued)

Item Description
Spare Part 
Number

Cable Kit 418876-001

5a
5b
5c
5d
5e

Pointing stick cable
TouchPad cable
Modem cable
Audio cable
Bluetooth cable

6 RTC battery 418880-001

7 Microphone 418903-001

8 Top cover 

Top cover (includes TouchPad, smart card reader, and 
fingerprint reader board)

Top cover (includes TouchPad and smart card reader)

418882-001

438169-001

Plastics Kit 418877-001

9a
9b
9c
9d
9e

PC Card slot bezel
Hard drive cover
Memory cover
Mini Card cover
Bluetooth cover

10 PC Card/digital media board 418884-001

11 Modem module 418849-001

12 Memory modules, 1-DIMM

PC2-5300
2048 MB
1024 MB
512 MB
256 MB

418857-001
418856-001
418855-001
418854-001

PC2-4200
2048 MB
1024 MB
512 MB
256 MB

418853-001
418852-001
418851-001
418850-001
Maintenance and Service Guide 3�5



Illustrated Parts Catalog
Computer Major Components
3�6 Maintenance and Service Guide



Illustrated Parts Catalog
Table 3-1

Spare Parts: Computer Major Components (Continued)

Item Description
Spare Part 
Number

13 Mini Card WWAN module 418860-001

For use with Verizon networks
For use with Vodafone networks
For use with Cingular networks

418860-001
435098-001
436668-001

14 Fan assembly 418886-001

15 System boards (include thermal grease, alcohol pad, and 
thermal pad)

128-MB discrete, for use only with heat sink with 
spare part number 418887-001
64-MB discrete, for use only with heat sink with 
spare part number 418887-001

418904-001

430495-001

UMA, for use only with heat sink with spare part 
number 418930-001

418931-001

16 Heat sinks (include thermal grease, alcohol pad, and thermal pad)

For use only with discrete system boards (spare part 
numbers 418904-001 and 430495-001)
For use only with discrete system boards
For use only with the UMA system board (spare part 
number 418931-001)
For use only with the UMA system board

418887-001

438875-001
418930-001

438876-001
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Illustrated Parts Catalog
Table 3-1

Spare Parts: Computer Major Components (Continued)

Item Description
Spare Part 
Number

17 Processors (include thermal grease, alcohol pad, and thermal pad)

Intel Core Duo T7600 (2.33-GHz) processor
Intel Core Duo T7400 (2.16-GHz) processor
Intel Core Duo T7200 (2.0-GHz) processor
Intel Core Duo T5600 (1.83-GHz) processor
Intel Core Duo T5500 (1.66-GHz) processor
Intel Core Duo T2300E (1.66-GHz) processor
Intel Core Duo T2600 (2.17-GHz) processor
Intel Core Duo T2500 (2.00-GHz) processor
Intel Core Duo T2400 (1.83-GHz) processor
Intel Core Duo T2300 (1.67-GHz) processor

435860-001
435861-001
435862-001
435863-001
435864-001
436012-001
418874-001
418870-001
418869-001
418868-001

Intel Core Solo T1300 (1.66-GHz) processor 418885-001

Intel Celeron M 440 (1.80 GHz) processor
Intel Celeron M 430 (1.73 GHz) processor

444966-001
444965-001

18 Speaker 418883-001

19 MultiBay II eject assembly 418905-001

20 Base enclosure (includes LED board and LED board 
cable)

418881-001

21 LED board (includes LED board cable) 418901-001

22 Hard drives

7200 rpm
100 GB
80 GB
60 GB

431125-001
431124-001
418861-001

5400 rpm
120 GB
100 GB
80 GB
60 GB
40 GB

440880-001
418863-001
418862-001
418859-001
418858-001
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Table 3-1

Spare Parts: Computer Major Components (Continued)

Item Description
Spare Part 
Number

23 MultiBay II drives (include bezel)

DVD±RW and CD-RW Double-Layer Combo Drive
DVD±RW and CD-RW Combo Drive
DVD-ROM drive

418866-001
418865-001
418864-001

24 Battery

8-cell, 5.1-AH
4-cell, 2.5-AH

418867-001
418871-001

25 Mini Card WLAN modules

802.11b/g HS WLAN module for use in North America 407107-001

802.11b/g HS WLAN module for use in the countries 
or regions listed below. These countries or regions are 
categorized as the rest of the world (ROW).

407107-002

China
Ecuador
Haiti

Honduras
Pakistan
Peru

Qatar
South Korea

Uruguay
Venezuela

802.11b/g HS WLAN module for use in Japan 407107-291

802.11b/g LJ WLAN module for use in North America 407108-001

802.11b/g LJ WLAN module for use in the countries or 
regions listed below. These countries or regions are 
categorized as the rest of the world (ROW).

407108-002

China
Ecuador
Haiti

Honduras
Pakistan
Peru

Qatar
South Korea

Uruguay
Venezuela

802.11b/g LJ WLAN module for use in Japan 407108-291
Maintenance and Service Guide 3�11



Illustrated Parts Catalog
Computer Major Components
3�12 Maintenance and Service Guide



Illustrated Parts Catalog
Table 3-1

Spare Parts: Computer Major Components (Continued)

Item Description
Spare Part 
Number

25 Mini Card WLAN modules (Continued)

802.11a/b/g GL WLAN module for use in the countries 
or regions listed below. These countries or regions are 
categorized as most of the world (MOW 1).

407576-001

Antigua & 
Barbuda

Argentina
Australia
Bahamas
Barbados
Brunei

Canada
Chile
Dominican 

Republic
Guam
Guatemala
Hong Kong

Panama
India
Indonesia
Malaysia
Mexico
New Zealand

Paraguay
Saudi Arabia
Taiwan
The United 

States
Vietnam

802.11a/b/g GL WLAN module for use in the countries 
or regions listed below. These countries or regions are 
categorized as most of the world (MOW 2).

407576-002

Aruba
Austria
Azerbaijan
Bahrain
Belgium
Bermuda
Bulgaria
Cayman Islands
Columbia
Croatia
Cyprus
Czech Republic
Denmark
Egypt

El Salvador
Estonia
Finland
France
Georgia
Germany
Greece
Hungary
Iceland
Ireland
Italy
Latvia
Lebanon
Philippines

Poland
Portugal
Romania
Russia
Serbia and 

Montenegro
Singapore
Slovakia
Liechtenstein
Lithuania
Luxembourg
Malta
Monaco
The Netherlands

Norway
Oman
Slovenia
South Africa
Spain
Sri Lanka
Sweden
Switzerland
Turkey
The United 

Kingdom
Uzbekistan
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Table 3-1

Spare Parts: Computer Major Components (Continued)

Item Description
Spare Part 
Number

25 Mini Card WLAN modules (Continued)

802.11a/b/g GL WLAN module for use in the countries 
or regions listed below. These countries or regions are 
categorized as the rest of the world (ROW).

407576-003

China
Ecuador
Haiti

Honduras
Pakistan
Peru

Qatar
South Korea

Uruguay
Venezuela

802.11a/b/g GL WLAN module for use in Japan 407576-291

802.11b/g GL WLAN module for use in Korea 407576-AD1

802.11b/g GL WLAN module for use in the following 
countries or regions:

409250-004

Israel
Jordan

Kuwait
Thailand

United Arab 
Emirates

Ukraine

26 Bluetooth® module (includes Bluetooth module cable) 409993-001
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3.3 Display Assembly Components
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Table 3-2

Display Assembly Components

Spare Part Number Information

Item Description
Spare Part 
Number

1 Display bezel 418889-001

2 Display panels
14.1-inch, WXGA+
14.1-inch, WXGA

418891-001
418890-001

3 Display Hinge Kit 418902-001

4 Display Inverter 418888-001

5 Wireless Antenna Kit 418899-001

6 Display enclosure 418895-001

Not illustrated:
Display Bracket Kit (includes left display bracket)
Display Cable Kit (for use with 14.1-inch, WXGA+ 
display panel)
Display Cable Kit (for use with 14.1-inch, WXGA 
display panel)
Display Screw Kit
Display Rubber Kit (includes all display bezel rubber 
and mylar screw covers)

418894-001
418898-001

418897-001

418892-001
418893-001
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3.4 Plastics Kit

Table 3-3

Plastics Kit

Spare Part Number Information

Item Description
Spare Part 
Number

Plastics Kit
Includes:

418877-001

1 PC Card slot bezel

2 Hard drive cover (includes 2 captive screws, captured by C clips)

3 Memory module compartment cover (includes 1 captive screw, 
captured by C clip)

4 Mini Card module compartment cover (includes 1 captive screw, 
captured by C clip)

5 Bluetooth module cover (includes 1 captive screw, captured by C clip)

6 Computer feet (4)
3�18 Maintenance and Service Guide



Illustrated Parts Catalog
3.5 Cable Kit

Table 3-4

Cable Kit

Spare Part Number Information

Item Description
Spare Part 
Number

Cable Kit
Includes:

418876-001

1 Pointing stick cable

2 Bluetooth module cable

3 Audio cable

4 Modem module cable

5 TouchPad cable
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3.6 Mass Storage Devices

Table 3-5

Mass Storage Devices

Spare Part Number Information

Item Description
Spare Part 
Number

1 Hard drives (include frame and connector)

7200 rpm
100 GB
80 GB
60 GB

431125-001
431124-001
418861-001

5400 rpm
120 GB
100 GB
80 GB
60 GB
40 GB

440880-001
418863-001
418862-001
418859-001
418858-001

2 Optical drives (include bezel)

DVD±RW and CD-RW Double-Layer Combo Drive
DVD±RW and CD-RW Combo Drive
DVD-ROM drive

418866-001
418865-001
418864-001
3�20 Maintenance and Service Guide



Illustrated Parts Catalog
3.7 Miscellaneous (Not Illustrated)

Table 3-6

Miscellaneous (Not Illustrated)

Spare Part Information

Description
Spare Part 
Number

90-watt non-PFC AC adapter 418873-001

90-watt PFC AC adapter 418875-001

65-watt PFC AC adapter 418872-001

External MultiBay II 366143-001

Fingerprint reader insert (for use as a filler in a non-used 
fingerprint reader)

438170-001

External MultiBay II power cable and stand 366144-001

HP Extended Life Battery 367456-001

HP Docking Station 374803-001

HP Docking Station Miscellaneous Plastics Kit 380089-001

Label Kit 418879-001

MultiBay 8X DVD-ROM Drive 373314-001

MultiBay 24X DVD/CD-RW Combo Drive 373315-001

Nylon carrying case 325814-001

USB 1.1 diskette drive 359118-001
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Power cords:

For use in the United States 350055-001

For use in Australia 350055-011

For use in Europe 350055-021

For use in the United Kingdom 350055-031

For use in Italy 350055-061

For use in Denmark 350055-081

For use in Brazil 350055-201

For use in Japan 350055-291

For use in the People’s Republic of China 350055-AA1

For use in Korea 350055-AD1

For use in Israel 350055-BB1

For use in Switzerland 350055-BG1

For use in French Canada 350055-DB1

Screw Kit (includes the following screws; refer to
Appendix A, “Screw Listing,” for more information on
specifications and usage)

418878-001

■ Phillips PM3.0×3.0 screw

■ Phillips PM2.5×17.0 screw

■ Phillips PM2.5×13.0 spring-loaded 
screw

■ Phillips PM2.5×7.0 screw

■ Phillips PM2.5×4.0 screw

■ Phillips PM2.0×6.0 screw

■ Phillips PM2.0×4.0 screw

■ Torx8 T8M2.5×19.0 screw

■ Torx8 T8M2.5×9.0 screw

■ Torx8 T8M2.5×7.0 screw

■ Torx8 T8M2.5×4.0 screw

Table 3-6

Miscellaneous (Not Illustrated)

Spare Part Information (Continued)

Description
Spare Part 
Number
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3.8 Sequential Part Number Listing

Table 3-7

Sequential Part Number Listing

Spare Part 
Number Description

325814-001 Nylon carrying case

350055-001 Power cord for use in the United States

350055-011 Power cord for use in Australia

350055-021 Power cord for use in Europe

350055-061 Power cord for use in Italy

350055-031 Power cord for use in the United Kingdom

350055-081 Power cord for use in Denmark

350055-201 Power cord for use in Brazil

350055-291 Power cord for use in Japan

350055-AA1 Power cord for use in the People’s Republic of China

350055-AD1 Power cord for use in Korea

350055-BB1 Power cord for use in Israel

350055-BG1 Power cord for use in Switzerland

350055-DB1 Power cord for use in French Canada

359118-001 USB 1.1 diskette drive

366143-001 External MultiBay II

366144-001 External MultiBay II power cable and stand

367456-001 HP Extended Life Battery

374803-001 HP Docking Station

380089-001 HP Docking Station Miscellaneous Plastics Kit
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407107-001 802.11b/g HS WLAN Mini Card module for use in 
North America

407107-002 802.11b/g HS WLAN Mini Card module for use in the ROW 
countries or regions listed below:

China
Ecuador
Haiti

Honduras
Pakistan
Peru

Qatar
South Korea

Uruguay
Venezuela

407107-291 802.11b/g HS WLAN module for use in Japan

407108-001 802.11b/g LJ WLAN module for use in North America

407108-002 802.11b/g LJ WLAN Mini Card module for use in the ROW 
countries or regions listed below:

China
Ecuador
Haiti

Honduras
Pakistan
Peru

Qatar
South Korea

Uruguay
Venezuela

407108-291 802.11b/g LJ WLAN module for use in Japan

407576-001 802.11a/b/g GL WLAN module for use in the MOW1 countries 
or regions listed below:

Antigua & 
Barbuda

Argentina
Australia
Bahamas
Barbados
Brunei

Canada
Chile
Dominican 

Republic
Guam
Guatemala
Hong Kong

Panama
India
Indonesia
Malaysia
Mexico
New Zealand

Paraguay
Saudi 

Arabia
Taiwan
The United 

States
Vietnam

Table 3-7

Sequential Part Number Listing (Continued)

Spare Part 
Number Description
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407576-002 802.11a/b/g GL WLAN Mini Card module for use in the MOW2 
countries or regions listed below:

Aruba
Austria
Azerbaijan
Bahrain
Belgium
Bermuda
Bulgaria
Cayman 

Islands
Columbia
Croatia
Cyprus
The Czech 

Republic
Denmark
Egypt

El Salvador
Estonia
Finland
France
Georgia
Germany
Greece
Hungary
Iceland
Ireland
Italy
Latvia
Lebanon
The 

Philippines

Poland
Portugal
Romania
Russia
Serbia and 

Montenegro
Singapore
Slovakia
Liechtenstein
Lithuania
Luxembourg
Malta
Monaco
The 

Netherlands

Norway
Oman
Slovenia
South Africa
Spain
Sri Lanka
Sweden
Switzerland
Turkey
The United 

Kingdom
Uzbekistan

407576-003 802.11a/b/g GL WLAN Mini Card module for use in the ROW 
countries or regions listed below:

China
Ecuador
Haiti

Honduras
Pakistan
Peru

Qatar
South Korea

Uruguay
Venezuela

407576-291 802.11a/b/g GL WLAN Mini Card module for use in Japan

409250-004 802.11b/g GL WLAN Mini Card module for use in the following 
countries or regions:

Israel
Jordan

Kuwait
Thailand

United Arab 
Emirates

Ukraine

409993-001 Bluetooth module (includes Bluetooth module cable)

418849-001 Modem module

418850-001 1-DIMM, PC2-4200, 256-MB memory module

Table 3-7

Sequential Part Number Listing (Continued)

Spare Part 
Number Description
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418851-001 1-DIMM, PC2-4200, 512-MB memory module

418852-001 1-DIMM, PC2-4200, 1024-MB memory module

418853-001 1-DIMM, PC2-4200, 2048-MB memory module

418854-001 1-DIMM, PC2-5300, 256-MB memory module

418855-001 1-DIMM, PC2-5300, 512-MB memory module

418856-001 1-DIMM, PC2-5300, 1024-MB memory module

418857-001 1-DIMM, PC2-5300, 2048-MB memory module

418858-001 5400-rpm, 40-GB hard drive

418859-001 5400-rpm, 60-GB hard drive

418860-001 Mini Card WWAN module for use with Verizon networks

418861-001 7200-rpm, 60-GB hard drive

418862-001 5400-rpm, 80-GB hard drive

418863-001 5400-rpm, 100-GB hard drive

418864-001 8X DVD-ROM Drive

418865-001 24X DVD/CD-RW Combo Drive

418866-001 DVD±RW and CD-RW Double-Layer Combo Drive

418867-001 8-cell, 5.1-AH battery

418868-001 Intel Core Duo T2300 (1.67-GHz) processor (includes 
thermal paste)

418869-001 Intel Core Duo T2400 (1.83-GHz) processor (includes 
thermal paste)

418870-001 Intel Core Duo T2500 (2.00-GHz) processor (includes 
thermal paste)

418871-001 4-cell, 2.5-AH battery

Table 3-7

Sequential Part Number Listing (Continued)

Spare Part 
Number Description
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418872-001 65-watt AC adapter

418873-001 90-watt non-PFC AC adapter

418874-001 Intel Core Duo T2600 (2.17-GHz) processor (includes thermal 
paste)

418875-001 90-watt PFC AC adapter

418876-001 Cable Kit

418877-001 Plastics Kit

418878-001 Screw Kit

418879-001 Label Kit

418880-001 RTC battery

418881-001 Base enclosure

418882-001 Top cover with 3 pointing stick buttons and 3 TouchPad 
buttons, for use with keyboards with Pointing Stick

418883-001 Speaker

418884-001 PC Card/digital media board

418885-001 Intel Core Solo T1300 (1.67-GHz) processor (includes thermal 
paste)

418886-001 Fan assembly

418887-001 Heat sink for use only with discrete system boards (spare part 
numbers 418904-001 and 430495-001, includes 
thermal grease, alcohol pad, and thermal pad)

418888-001 Display Inverter

418889-001 Display bezel

418890-001 14.1-inch, WXGA display panel

Table 3-7

Sequential Part Number Listing (Continued)

Spare Part 
Number Description
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418891-001 14.1-inch, WXGA+ display panel

418892-001 Display Screw Kit

418893-001 Display Rubber Kit

418894-001 Display Bracket Kit

418895-001 Display enclosure

418896-001 14.1-inch, WXGA display assembly (includes wireless antenna 
transceivers and cables)

418897-001 Display Cable Kit for use with WXGA display panel

418898-001 Display Cable Kit for use with WXGA+ display panel

418899-001 Wireless Antenna Kit

418900-001 Switch cover

418901-001 LED board (includes LED board cable)

418902-001 Display Hinge Kit

418903-001 Microphone

418904-001 128-MB discrete system board, for use only with heat sink with 
spare part number 418887-001 (includes thermal grease, 
alcohol pad, and thermal pad)

418905-001 MultiBay II eject assembly

418907-001 14.1-inch, WXGA+ display assembly (includes wireless 
antenna transceivers and cables)

418908-001 Power button board (includes power button board cable)

418910-001 Keyboard for use in the United States

418910-021 Keyboard for international use

418910-031 Keyboard for use in the United Kingdom

Table 3-7

Sequential Part Number Listing (Continued)

Spare Part 
Number Description
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418910-041 Keyboard for use in Germany

418910-051 Keyboard for use in France

418910-061 Keyboard for use in Italy

418910-071 Keyboard for use in Spain

418910-081 Keyboard for use in Denmark

418910-091 Keyboard for use in Norway

418910-101 Keyboard for use in Sweden/Finland

418910-111 Keyboard for use in Switzerland

418910-121 Keyboard for use in French Canada

418910-131 Keyboard for use in Portugal

418910-141 Keyboard for use in Turkey

418910-151 Keyboard for use in Greece

418910-161 Keyboard for use in Latin America

418910-171 Keyboard for use in Saudi Arabia

418910-201 Keyboard for use in Brazil

418910-211 Keyboard for use in Hungary

418910-221 Keyboard for use in the Czech Republic

418910-231 Keyboard for use in Slovakia

418910-251 Keyboard for use in Russia

418910-281 Keyboard for use in Thailand

418910-291 Keyboard for use in Japan

418910-A41 Keyboard for use in Belgium

Table 3-7

Sequential Part Number Listing (Continued)

Spare Part 
Number Description
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418910-AB1 Keyboard for use in Taiwan

418910-AD1 Keyboard for use in Korea

418910-BA1 Keyboard for use in Slovenia

418910-BB1 Keyboard for use in Israel

418910-DD1 Keyboard for use in Iceland

418930-001 Heat sink for use only with the UMA system board, spare part 
number 418931-001 (includes thermal grease, alcohol pad, 
and thermal pad)

418931-001 UMA system board, for use only with heat sink with spare part 
number 418930-001 (includes thermal grease, alcohol pad, 
and thermal pad)

430495-001 64-MB discrete system board, for use only with heat sink with 
spare part number 418887-001 (includes thermal grease, 
alcohol pad, and thermal pad)

431124-001 7200-rpm, 80-GB hard drive

431125-001 7200-rpm, 100-GB hard drive

435098-001 Mini Card WWAN module for use with Vodafone networks

435860-001 Intel Core Duo T7600 (2.33-GHz) processor

435861-001 Intel Core Duo T7400 (2.16-GHz) processor

435862-001 Intel Core Duo T7200 (2.0-GHz) processor

435863-001 Intel Core Duo T5600 (1.83-GHz) processor

435864-001 Intel Core Duo T5500 (1.66-GHz) processor

436012-001 Intel Core Duo T2300E (1.66-GHz) processor

436668-001 Mini Card WWAN module for use with Cingular networks

438169-001 Top cover (includes TouchPad and smart card reader)

Table 3-7

Sequential Part Number Listing (Continued)

Spare Part 
Number Description
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438170-001 Fingerprint reader insert (for use as a filler in a non-used 
fingerprint reader)

438875-001 Heat sink for use only with discrete system boards (spare part 
numbers 418904-001 and 430495-001), includes 
thermal grease, alcohol pad, and thermal pad

438876-001 Heat sink for use only with the UMA system board (spare part 
number 418931-001), includes thermal grease, alcohol pad, 
and thermal pad

440880-001 5400-rpm, 120-GB hard drive

444966-001 Intel Celeron M 440 (1.80-GHz) processor

444965-001 Intel Celeron M 430 (1.73-GHz) processor

Table 3-7

Sequential Part Number Listing (Continued)

Spare Part 
Number Description
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4
Removal and Replacement

Preliminaries

This chapter provides essential information for proper and 
safe removal and replacement service.

4.1 Tools Required
You will need the following tools to complete the removal and 
replacement procedures:
■ Magnetic screwdriver
■ Phillips P0 and P1 screwdrivers
■ Torx8 screwdriver
■ Flat-bladed screwdriver
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4.2 Service Considerations
The following sections include some of the considerations 
that you should keep in mind during disassembly and assembly 
procedures.

✎ As you remove each subassembly from the computer, place 
the subassembly (and all accompanying screws) away from 
the work area to prevent damage.

Plastic Parts

Using excessive force during disassembly and reassembly can 
damage plastic parts. Use care when handling the plastic parts. 
Apply pressure only at the points designated in the maintenance 
instructions.

Cables and Connectors

Ä
CAUTION: When servicing the computer, be sure that cables are 
placed in their proper locations during the reassembly process. 
Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. 
Apply only the tension required to unseat or seat the cables 
during removal and insertion. Handle cables by the connector 
whenever possible. In all cases, avoid bending, twisting, or 
tearing cables. Be sure that cables are routed in such a way that 
they cannot be caught or snagged by parts being removed or 
replaced. Handle flex cables with extreme care; these cables 
tear easily.
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4.3 Preventing Damage to 
Removable Drives
Removable drives are fragile components that must be handled 
with care. To prevent damage to the computer, damage to a 
removable drive, or loss of information, observe the following 
precautions:
■ Before removing or inserting a hard drive, shut down the 

computer. If you are unsure whether the computer is off or 
in hibernation, turn the computer on, and then shut it down 
through the operating system.

■ Before removing a diskette drive or optical drive, be sure that 
a diskette or disc is not in the drive and be sure that the optical 
drive tray is closed.

■ Before handling a drive, be sure that you are discharged of 
static electricity. While handling a drive, avoid touching the 
connector.

■ Handle drives on surfaces covered with at least one inch of 
shock-proof foam.

■ Avoid dropping drives from any height onto any surface.
■ After removing a hard drive, an optical drive, or a diskette 

drive, place it in a static-proof bag.
■ Avoid exposing a hard drive to products that have magnetic 

fields, such as monitors or speakers.
■ Avoid exposing a drive to temperature extremes or liquids.
■ If a drive must be mailed, place the drive in a bubble pack 

mailer or other suitable form of protective packaging and label 
the package “FRAGILE: Handle With Care.”
Maintenance and Service Guide 4�3



Removal and Replacement Preliminaries
4.4 Preventing Electrostatic Damage
Many electronic components are sensitive to electrostatic 
discharge (ESD). Circuitry design and structure determine the 
degree of sensitivity. Networks built into many integrated circuits 
provide some protection, but in many cases, the discharge 
contains enough power to alter device parameters or melt 
silicon junctions.

A sudden discharge of static electricity from a finger or other 
conductor can destroy static-sensitive devices or microcircuitry. 
Often the spark is neither felt nor heard, but damage occurs.

An electronic device exposed to electrostatic discharge might not 
be affected at all and can work perfectly throughout a normal 
cycle. Or the device might function normally for a while, then 
degrade in the internal layers, reducing its life expectancy.
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4.5 Packaging and Transporting 
Precautions
Use the following grounding precautions when packaging and 
transporting equipment:
■ To avoid hand contact, transport products in static-safe 

containers, such as tubes, bags, or boxes.
■ Protect all electrostatic-sensitive parts and assemblies with 

conductive or approved containers or packaging.
■ Keep electrostatic-sensitive parts in their containers until 

the parts arrive at static-free workstations.
■ Place items on a grounded surface before removing items 

from their containers.
■ Always be properly grounded when touching a sensitive 

component or assembly.
■ Store reusable electrostatic-sensitive parts from assemblies 

in protective packaging or nonconductive foam.
■ Use transporters and conveyors made of antistatic belts and 

roller bushings. Be sure that mechanized equipment used for 
moving materials is wired to ground and that proper materials 
are selected to avoid static charging. When grounding is not 
possible, use an ionizer to dissipate electric charges.
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4.6 Workstation Precautions
Use the following grounding precautions at workstations:
■ Cover the workstation with approved static-shielding material 

(refer to Table 4-2, “Static-Shielding Materials”).
■ Use a wrist strap connected to a properly grounded work 

surface and use properly grounded tools and equipment.
■ Use conductive field service tools, such as cutters, 

screwdrivers, and vacuums.
■ When fixtures must directly contact dissipative surfaces, use 

fixtures made only of static-safe materials.
■ Keep the work area free of nonconductive materials, such 

as ordinary plastic assembly aids and Styrofoam.
■ Handle electrostatic-sensitive components, parts, and 

assemblies by the case or PCM laminate. Handle these 
items only at static-free workstations.

■ Avoid contact with pins, leads, or circuitry.
■ Turn off power and input signals before inserting or removing 

connectors or test equipment.
4�6 Maintenance and Service Guide



Removal and Replacement Preliminaries
4.7 Grounding Equipment and 
Methods
Grounding equipment must include either a wrist strap or a 
foot strap at a grounded workstation.
■ When seated, wear a wrist strap connected to a grounded 

system. Wrist straps are flexible straps with a minimum of 
one megohm ±10% resistance in the ground cords. To provide 
proper ground, wear a strap snugly against the skin at all times. 
On grounded mats with banana-plug connectors, use alligator 
clips to connect a wrist strap.

■ When standing, use foot straps and a grounded floor mat. 
Foot straps (heel, toe, or boot straps) can be used at standing 
workstations and are compatible with most types of shoes 
or boots. On conductive floors or dissipative floor mats, use 
foot straps on both feet with a minimum of one megohm 
resistance between the operator and ground. To be effective, 
the conductive strips must be worn in contact with the skin.

Other grounding equipment recommended for use in preventing 
electrostatic damage includes
■ Antistatic tape.
■ Antistatic smocks, aprons, and sleeve protectors.
■ Conductive bins and other assembly or soldering aids.
■ Nonconductive foam.
■ Conductive tabletop workstations with ground cords of 

one megohm resistance.
■ Static-dissipative tables or floor mats with hard ties to 

the ground.
■ Field service kits.
■ Static awareness labels.
■ Material-handling packages.
■ Nonconductive plastic bags, tubes, or boxes.
■ Metal tote boxes.
■ Electrostatic voltage levels and protective materials.
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Removal and Replacement Preliminaries
Table 4-1 shows how humidity affects the electrostatic voltage 
levels generated by different activities.

Table 4-2 lists the shielding protection provided by antistatic 
bags and floor mats.

Table 4-1

Typical Electrostatic Voltage Levels

Relative Humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V  5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V

✎ A product can be degraded by as little as 700 V.

Table 4-2

Static-Shielding Materials

Material Use Voltage Protection Level

Antistatic plastic Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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5
Removal and Replacement

Procedures

This chapter provides removal and replacement procedures.

There are as many as 81 screws, in 14 different sizes, that must be 
removed, replaced, or loosened when servicing the computer. 
Make special note of each screw size and location during removal 
and replacement.

Refer to Appendix A, “Screw Listing” for detailed information 
on screw sizes, locations, and usage.
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Removal and Replacement Procedures
5.1 Serial Number
Report the computer serial number to HP when requesting 
information or ordering spare parts. The serial number is 
located on the bottom of the computer.

Serial Number Location
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Removal and Replacement Procedures
5.2 Disassembly Sequence Chart
Use the chart below to determine the section number to be 
referenced when removing computer components.

Disassembly Sequence Chart

Section Description # of Screws Removed

5.3 Preparing the Computer for 
Disassembly

Battery 0

5.4 Hard Drive 2 loosened to remove the 
hard drive cover
1 loosened to remove the 
hard drive
4 to disassemble the 
hard drive

5.5 Computer Feet 0

5.6 Bluetooth Module 1 loosened

5.7 External Memory Module 1 loosened to remove the 
memory module 
compartment cover

5.8 Mini Card WLAN Module 1 loosened to remove the 
Mini Card module 
compartment cover
2 removed to remove the 
Mini Card WLAN module

Å To prevent an unresponsive system and the display of a 
warning message, install only a Mini Card device 
authorized for use in your computer by the governmental 
agency that regulates wireless devices in your country or 
region. If you install a device and then receive a warning 
message, remove the device to restore computer 
functionality. Then contact technical support by selecting 
Start > Help and Support > Contact support..

5.9 MultiBay II Device 1
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Removal and Replacement Procedures
Section Description # of Screws Removed

5.10 Keyboard 3

5.11 RTC Battery 0

5.12 Internal Memory Module 0

5.13 Modem Module 2

5.14 Mini Card WWAN Module 2

5.15 Switch Cover 6

5.16 Power Button Board 2

5.17 Fan Assembly 1

5.18 Heat Sink 6 loosened

5.19 Processor 1 loosened

5.20 Display Assembly
Display bezel
Display hinges
Display panel
Display inverter
Wireless antenna transceivers

7
4
4
6
0
2

5.21 Top Cover 12

5.22 PC Card/Digital Media Board 3

5.23 Speaker 0

5.24 Microphone 0

5.25 System Board 6

5.26 MultiBay II Eject Assembly 1

Disassembly Sequence Chart (Continued)
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Removal and Replacement Procedures
5.3 Preparing the Computer for 
Disassembly
Before you begin any removal or installation procedures: 

1. Shut down the computer. If you are unsure whether the 
computer is off or in hibernation, turn the computer on, 
and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power cord.
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Removal and Replacement Procedures
4. Remove the battery by following these steps:

a. Turn the computer upside down with the rear panel 
toward you.

b. Slide the battery release latch on the right 1 and then the 
battery release latch on the left 2 to release the battery.

c. Slide the battery 3 straight back and remove it.

Removing the Battery

Reverse the above procedure to install the battery.

Battery Spare Part Number Information

8-cell, 5.1-AH
4-cell, 2.5-AH

418867-001
418871-001
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Removal and Replacement Procedures
5.4 Hard Drive

1. Prepare the computer for disassembly (refer to Section 5.3).

2. Position the computer with the front toward you.

Hard Drive Spare Part Number Information

7200 rpm
100 GB
80 GB
60 GB

431125-001
431124-001
418861-001

5400 rpm
120 GB
100 GB
80 GB
60 GB
40 GB

440880-001
418863-001
418862-001
418859-001
418858-001
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Removal and Replacement Procedures
3. Loosen the two Phillips PM2.0×5.0 screws 1 that secure the 
hard drive cover to the computer.

4. Lift the right side of the hard drive cover 2 and swing it up 
and to the left.

5. Remove the hard drive cover.

✎ The hard drive cover is included in the Plastics Kit, spare part 
number 418877-001.

Removing the Hard Drive Cover
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Removal and Replacement Procedures
6. Loosen the Phillips PM2.5×13.0 spring-loaded hard drive 
retention screw 1.

7. Grasp the mylar tab 2 on the hard drive and slide the hard 
drive 3 to the left to disconnect it from the system board.

8. Remove the hard drive 4 from the hard drive bay.

Removing the Hard Drive
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Removal and Replacement Procedures
9. Remove the four Phillips PM3.0×3.0 hard drive frame 
screws 1 from each side of the hard drive.

10. Lift the frame 2 straight up to remove if from the hard drive.

Removing the Hard Drive Frame

Reverse the above procedure to reassemble and install the 
hard drive.
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Removal and Replacement Procedures
5.5 Computer Feet
The computer feet are adhesive-backed rubber pads. The feet are 
included in the Plastics Kit, spare part number 418877-001.

Replacing the Computer Feet
Maintenance and Service Guide 5�11



Removal and Replacement Procedures
5.6 Bluetooth Module

1. Prepare the computer for disassembly (refer to Section 5.3).

2. Loosen the Phillips PM2.0×5.0 screw 1 that secures the 
Bluetooth module cover to the computer.

3. Remove the Bluetooth module cover 2.

Removing the Bluetooth Module Cover

Bluetooth Module Spare Part Number Information

Bluetooth module (includes Bluetooth module cable) 409993-001
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Removal and Replacement Procedures
4. Slide the Bluetooth module 1 to the right until the left side 
of the module is clear of the left side of the clip in the base 
enclosure.

5. Swing the left side of the Bluetooth module 2 out of the base 
enclosure.

6. Slide the Bluetooth module 3 to the left until it is removed 
from the base enclosure.

7. Disconnect the Bluetooth module cable 4 from the Bluetooth 
module.

8. Remove the Bluetooth module.

✎ The Bluetooth module cable is included with the Bluetooth 
module spare part kit and is also available in the Cable Kit, 
spare part number 418876-001.

Removing the Bluetooth Module

Reverse the above procedure to install a Bluetooth module.
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Removal and Replacement Procedures
5.7 External Memory Module

1. Prepare the computer for disassembly (refer to Section 5.3).

2. Position the computer with the front toward you.

Memory Module Spare Part Number Information

PC2-5300
2048 MB
1024 MB
512 MB
256 MB

418857-001
418856-001
418855-001
418854-001

PC2-4200
2048 MB
1024 MB
512 MB
256 MB

418853-001
418852-001
418851-001
418850-001
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Removal and Replacement Procedures
3. Loosen the Phillips PM2.0×5.0 screw 1 that secures the 
memory module compartment cover to the computer.

4. Lift the right edge of the cover 2 and swing it up and to the 
left.

5. Remove the memory module compartment cover.

✎ The memory module compartment cover is included in the 
Plastics Kit, spare part number 418877-001.

Removing the Memory Module Compartment Cover
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Removal and Replacement Procedures
6. Spread the retaining tabs 1 on each side of the memory 
module socket to release the memory module. (The edge of 
the module opposite the socket rises away from 
the computer.)

7. Slide the module 2 away from the socket at an angle.

8. Remove the memory module.

✎ Memory modules are designed with a notch 3 to prevent 
incorrect installation into the memory module socket.

Removing the Memory Module

Reverse the above procedure to install a memory module.
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Removal and Replacement Procedures
5.8 Mini Card WLAN Module

Mini Card WLAN Module

Spare Part Number Information

802.11b/g HS WLAN module for use in North America 407107-001

802.11b/g HS WLAN module for use in the countries or regions 
listed below. These countries or regions are categorized as the 
rest of the world (ROW).

407107-002

China
Ecuador
Haiti

Honduras
Pakistan
Peru

Qatar
South Korea

Uruguay
Venezuela

802.11b/g HS WLAN module for use in Japan 407107-291

802.11b/g LJ WLAN module for use in North America 407108-001

802.11b/g LJ WLAN module for use in the ROW countries or 
regions listed below:

407108-002

China
Ecuador
Haiti

Honduras
Pakistan
Peru

Qatar
South Korea

Uruguay
Venezuela

802.11b/g LJ WLAN module for use in Japan 407108-291

802.11a/b/g GL WLAN module for use in the countries or 
regions listed below. These countries or regions are categorized 
as most of the world 1 (MOW1).

407576-001

Antigua & Barbuda
Argentina
Australia
Bahamas
Barbados
Brunei
Canada

Chile
Dominican 

Republic
Guam
Guatemala
Hong Kong

Panama
India
Indonesia
Malaysia
Mexico
New Zealand

Paraguay
Saudi Arabia
Taiwan
The United 

States
Vietnam
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802.11a/b/g GL WLAN module for use in the countries or 
regions listed below. These countries or regions are categorized 
as most of the world 2 (MOW2).

407576-002

Aruba
Austria
Azerbaijan
Bahrain
Belgium
Bermuda
Bulgaria
Cayman Islands
Columbia
Croatia
Cyprus
Czech Republic
Denmark
Egypt
El Salvador

Estonia
Finland
France
Georgia
Germany
Greece
Hungary
Iceland
Ireland
Italy
Latvia
Lebanon
The 

Philippines

Poland
Portugal
Romania
Russia
Serbia and Montenegro
Singapore
Slovakia
Liechtenstein
Lithuania
Luxembourg
Malta
Monaco
The Netherlands

Norway
Oman
Slovenia
South Africa
Spain
Sri Lanka
Sweden
Switzerland
Turkey
The United 

Kingdom
Uzbekistan

802.11a/b/g GL WLAN module for use in the ROW countries or 
regions listed below:

407576-003

China
Ecuador
Haiti

Honduras
Pakistan
Peru

Qatar
South Korea

Uruguay
Venezuela

802.11a/b/g GL WLAN module for use in Japan 407576-291

802.11b/g GL WLAN module for use in Korea 407576-AD1

802.11b/g GL WLAN module for use in the following countries 
or regions:

409250-004

Israel
Jordan

Kuwait
Thailand

United Arab Emirates Ukraine

Mini Card WLAN Module

Spare Part Number Information (Continued)
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Removal and Replacement Procedures
1. Prepare the computer for disassembly (Section 5.3).

2. Position the computer with the front toward you.

3. Loosen the Phillips PM2.0×5.0 screw 1 that secures the 
Mini Card module compartment cover to the computer.

4. Lift the front of the cover 2 and swing it up and toward 
the back of the computer.

5. Remove the Mini Card module compartment cover.

✎ The Mini Card module compartment cover is included in the 
Plastics Kit, spare part number 418877-001.

Removing the Mini Card Module Compartment Cover
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Removal and Replacement Procedures
6. Make note of which wireless antenna cable is attached to 
which antenna clip on the Mini Card WLAN module before 
disconnecting the cables, then disconnect the auxiliary and 
main wireless antenna cables 1 from the Mini Card WLAN 
module.

✎ The wireless antenna cables are available in the 
Wireless Antenna Kit, spare part number 418899-001.

7. Remove the two Phillips PM2.0×3.0 screws 2 that secure the 
Mini Card WLAN module to the computer. (The edge of 
the module opposite the socket rises away from the 
computer.)

8. Remove the Mini Card WLAN module 3 by pulling the 
module away from the socket at an degree angle.

✎ Mini Card modules are designed with a notch 4 to prevent 
incorrect installation.

Removing a Mini Card WLAN Module

Reverse the above procedure to install a Mini Card WLAN 
module.
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Removal and Replacement Procedures
5.9 MultiBay II Device

1. Prepare the computer for disassembly (Section 5.3).

2. Position the computer with the left side toward you.

MultiBay II Device Spare Part Number Information

DVD±RW and CD-RW Double-Layer Combo Drive
DVD±RW and CD-RW Combo Drive
DVD-ROM drive

418866-001
418865-001
418864-001
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Removal and Replacement Procedures
3. Remove the Phillips PM2.5×5.0 screw 1 that secures the 
MultiBay II device to the computer.

4. Push in on the right side of the MultiBay II device 2. 
(The MultiBay II device partially protrudes from the 
MultiBay II.)

5. Slide the MultiBay II device 3 out of the computer.

Removing the MultiBay II Device

Reverse the above procedure to install an MultiBay II device.
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Removal and Replacement Procedures
5.10 Keyboard

1. Prepare the computer for disassembly (Section 5.3).

2. Position the computer with the front toward you.

Keyboard Spare Part Number Information

For use in:

Belgium
Brazil
The Czech Republic
Denmark
France
French Canada
Germany
Greece
Hungary
Iceland
Internationally
Israel
Italy
Japan
Korea

418910-A41
418910-201
418910-221
418910-081
418910-051
418910-121
418910-041
418910-151
418910-211
418910-DD1
418910-021
418910-BB1
418910-061
418910-291
418910-AD1

Latin America
Norway
Portugal
Russia
Saudi Arabia
Slovakia
Slovenia
Spain
Sweden/Finland
Switzerland
Taiwan
Thailand
Turkey
The United Kingdom
The United States

418910-161
418910-091
418910-131
418910-251
418910-171
418910-231
418910-BA1
418910-071
418910-101
418910-111
418910-AB1
418910-281
418910-141
418910-031
418910-001
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Removal and Replacement Procedures
3. Remove the three Torx8 T8M2.5×11.0 screws that secure the 
keyboard to the computer.

Removing the Keyboard Screws
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Removal and Replacement Procedures
4. Turn the computer display-side up with the front toward you.

5. Open the computer as far as possible.

6. Slide the four release tabs 1 on the rear edge of the keyboard 
forward.

7. Lift the rear edge of the keyboard 2 and swing it up toward 
you until it rests on the palm rest.

Releasing the Keyboard
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Removal and Replacement Procedures
8. Release the zero insertion force (ZIF) connector 1 to which 
the keyboard cable is attached and disconnect the keyboard 
cable 2.

9. Release the ZIF connector 3 to which the pointing stick 
cable is attached and disconnect the pointing stick cable 4.

10. Remove the keyboard.

Disconnecting the Keyboard and Pointing Stick Cables
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Removal and Replacement Procedures
11. If it is necessary to replace the pointing stick cable, turn the 
keyboard upside down with the space bar toward you.

12. Release the ZIF connector 1 to which the pointing stick 
cable is attached and disconnect the pointing stick cable 2.

✎ The pointing stick cable is included with all keyboard spare 
part kits and is also available in the Cable Kit, spare part 
number 418876-001.

Removing the Pointing Stick Cable

Reverse the above procedure to install the keyboard.
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5.11 RTC Battery

✎ The RTC battery is included in the Plastics Kit, spare part 
number 418877-001.

1. Prepare the computer for disassembly (Section 5.3).

2. Release the keyboard (Section 5.10).

3. Disconnect the RTC battery cable 1 from the system board 
and remove the cable from the clips 2 in the top cover.

4. Remove the RTC battery 3 from the clip in the 
base enclosure.

✎ The RTC battery is secured to the top cover by two-sided tape.

Removing the RTC Battery

Reverse the above procedure to install an RTC battery.
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Removal and Replacement Procedures
5.12 Internal Memory Module

1. Prepare the computer for disassembly (Section 5.3).

2. Release the keyboard (Section 5.10).

Memory Module Spare Part Number Information

PC2-5300
2048 MB
1024 MB
512 MB
256 MB

418857-001
418856-001
418855-001
418854-001

PC2-4200
2048 MB
1024 MB
512 MB
256 MB

418853-001
418852-001
418851-001
418850-001
Maintenance and Service Guide 5�29



Removal and Replacement Procedures
3. Spread the retaining tabs 1 on each side of the memory 
module socket to release the memory module. (The edge of 
the module opposite the socket rises away from 
the computer.)

4. Slide the module 2 away from the socket at an angle.

5. Remove the memory module.

✎ Memory modules are designed with a notch 3 to prevent 
incorrect installation into the memory module socket.

Removing the Memory Module

Reverse the above procedure to install a memory module.
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Removal and Replacement Procedures
5.13 Modem Module

1. Prepare the computer for disassembly (Section 5.3).

2. Release the keyboard (Section 5.10).

Modem Module Spare Part Number Information

Modem module 418849-001
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Removal and Replacement Procedures
3. Remove the two Phillips PM2.0×6.0 screws 1 that secure the 
modem module to the system board.

4. Lift the right side of the modem module 2 to disconnect it 
from the system board.

5. Disconnect the modem module cable 3 from the 
modem module.

✎ The modem module cable is included in the modem module 
spare part kit and is also available in the Cable Kit, spare part 
number 418876-001.

6. Remove the modem module.

Removing the Modem Module

Reverse the above procedure to install the modem module.
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Removal and Replacement Procedures
5.14 Mini Card WWAN Module

1. Prepare the computer for disassembly (Section 5.3).

2. Release the keyboard (Section 5.10).

Mini Card WWAN Module

Spare Part Number Information

For use with Verizon networks
For use with Vodafone networks
For use with Cingular networks

418860-001
435098-001
436668-001
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3. Make note of which wireless antenna cable is attached to 
which antenna clip on the Mini Card WWAN module before 
disconnecting the cables, then disconnect the auxiliary and 
main wireless antenna cables 1 from the Mini Card WWAN 
module.

✎ The wireless antenna cables are available in the 
Wireless Antenna Kit, spare part number 418899-001.

4. Remove the two Phillips PM2.0×3.0 screws 2 that secure the 
Mini Card WWAN module to the computer. (The edge of 
the module opposite the socket rises away from the 
computer.)

5. Remove the Mini Card WWAN module 3 by pulling the 
module away from the socket at an angle.

✎ Mini Card modules are designed with a notch 4 to prevent 
incorrect installation.

Removing a Mini Card WWAN Module

Reverse the above procedure to install a Mini Card WWAN 
module.
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Removal and Replacement Procedures
5.15 Switch Cover

1. Prepare the computer for disassembly (Section 5.3).

2. Remove the keyboard (Section 5.10).

3. Turn the computer upside down with the rear panel 
toward you.

4. Remove the two T8M2.5×11.0 screws 1 and the four Phillips 
PM2.0×2.0 screws 2 that secure the switch cover to the 
computer.

Removing the Switch Cover Screws

Switch Cover Spare Part Number Information

Switch cover 418900-001
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Removal and Replacement Procedures
5. Turn the computer display-side up with front toward you.

6. Open the computer as far as possible.

7. Disconnect the power button board cable 1 from the 
system board.

8. Insert a thin flat-bladed tool under the hinge cover sections 2 
of the switch cover and lift up until the switch cover 3 
disengages from the computer.

9. Remove the switch cover.

Removing the Switch Cover

Reverse the above procedure to install the switch cover.
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5.16 Power Button Board

1. Prepare the computer for disassembly (Section 5.3).

2. Remove the keyboard (Section 5.10).

3. Remove the switch cover (Section 5.15).

4. Remove the two Phillips PM2.5×4.0 screws 1 that secure the 
power button board to the switch cover.

5. Remove the power button board 2 from the switch cover.

Removing the Power Button Board

Reverse the above procedure to install the power button board.

Power Button Board Spare Part Number Information

Power button board (includes power button board cable) 418908-001
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5.17 Fan Assembly

1. Prepare the computer for disassembly (Section 5.3).

2. Remove the keyboard (Section 5.10).

3. Remove the switch cover (Section 5.15).

4. Disconnect the fan cable 1 from the system board.

5. Remove the Torx8 T8M2.5×7.0 screw 2 that secures the 
fan assembly to the base enclosure.

6. Remove the fan assembly 3 from the computer.

Removing the Fan Assembly

Reverse the above procedure to install the fan assembly.

Fan Assembly Spare Part Number Information

Fan assembly 418886-001
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5.18 Heat Sink

1. Prepare the computer for disassembly (Section 5.3), 
and then remove the following components:

a. Keyboard (Section 5.10)

b. Switch cover (Section 5.15)

c. Fan assembly (Section 5.17)

d. Heat sink (Section 5.18)

 Heat Sink Spare Part Number Information

✎ All heat sink spare part kits include thermal grease, alcohol pads, and 
thermal pads.

For use only with discrete system boards (spare part numbers 
418904-001 and 430495-001)
For use only with discrete system boards
For use only with the UMA system board (spare part number 
418931-001)
For use only with the UMA system board

418887-001

438875-001

418930-001
438876-001
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Removal and Replacement Procedures
2. Noting the required screw removal sequence, loosen the four 
Phillips PM2.0×10.0 screws 1 and the two Phillips 
PM2.0×13.0 screws 2 that secure the heat sink to the system 
board.

✎ The heat sink has numbers stamped on it that indicate the 
required screw removal sequence. You must remove screws in 
the order indicated to avoid over torque and binding problems.

3. Remove the heat sink 3 from the base enclosure.

✎ Due to the adhesive quality of the thermal paste located 
between the heat sink and processor, it may be necessary 
to move the heat sink from side to side to detach the heat sink 
from the processor.

Removing the Heat Sink
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Removal and Replacement Procedures
✎ The thermal paste and thermal pads should be thoroughly 
cleaned from the surfaces of the heat sink 1, processor 2, 
Chip1 3, and Chip2 4 each time the heat sink is removed. 
Thermal paste and thermal pads are included with all heat sink, 
processor, and system board spare part kits.

Thermal Paste and Thermal Pad Locations

Reverse the above procedure to install the heat sink.
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5.19 Processor

1. Prepare the computer for disassembly (Section 5.3), 
and then remove the following components:

a. Keyboard (Section 5.10)

b. Switch cover (Section 5.15)

c. Fan assembly (Section 5.17)

d. Heat sink (Section 5.18)

Processor Spare Part Number Information

Intel Core Duo T7600 (2.33-GHz) processor
Intel Core Duo T7400 (2.16-GHz) processor
Intel Core Duo T7200 (2.0-GHz) processor
Intel Core Duo T5600 (1.83-GHz) processor
Intel Core Duo T5500 (1.66-GHz) processor
Intel Core Duo T2300E (1.66-GHz) processor
Intel Core Duo T2600 (2.17-GHz) processor
Intel Core Duo T2500 (2.00-GHz) processor
Intel Core Duo T2400 (1.83-GHz) processor
Intel Core Duo T2300 (1.67-GHz) processor

435860-001
435861-001
435862-001
435863-001
435864-001
436012-001
418874-001
418870-001
418869-001
418868-001

Intel Core Solo T1300 (1.66-GHz) processor 418885-001

Intel Celeron M 440 (1.80-GHz) processor
Intel Celeron M 430 (1.73-GHz) processor

444966-001
444965-001
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Removal and Replacement Procedures
2. Use a flat-bladed screwdriver to turn the processor locking 
screw 1 one-half turn counterclockwise until you hear a 
click.

3. Lift the processor 2 straight up and remove it.

✎ The gold triangle 3 on the processor should be aligned with 
the triangle icon 4 on the processor socket when you install the 
processor.

Removing the Processor

Reverse the above procedure to install the processor.
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5.20 Display Assembly

1. Prepare the computer for disassembly (Section 5.3).

2. Disconnect the wireless antenna cables from the Mini Card 
WLAN module (Section 5.8).

3. Remove the keyboard (Section 5.10).

4. Disconnect the wireless antenna cables from the Mini Card 
WWAN module (Section 5.14).

5. Remove the switch cover (Section 5.15).

Display Assembly Spare Part Number Information

14.1-inch, WXGA+
14.1-inch, WXGA

418907-001
418896-001
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6. Close the computer and turn it upside down with the 
rear panel toward you.

7. Remove the following screws:

1 Two Torx8 T8M2.5×11.0 screws from the computer 
bottom

2 Two Torx8 T8M2.5×7.0 screws from the computer 
rear panel

3 One Phillips PM2.5×5.0 screw from the computer battery 
bay

Removing the Display Assembly Screws
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Removal and Replacement Procedures
8. Turn the computer display-side up with the front toward you.

9. Open the computer as far as it will open.

10. Disconnect the display cable 1 from the system board.

11. Remove the wireless antenna cables 2 and 3 from the 
Mini Card compartment and the top cover clips.

Disconnecting the Display Cable and Removing the Wireless 
Antenna Cables
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Removal and Replacement Procedures
Ä
CAUTION: Support the display assembly when removing the following 
screws. Failure to support the display assembly can result in damage to 
the display assembly and other computer components.

12. Remove the two Torx8 T8M2.5×7.0 screws 1 that secure the 
display assembly to the computer.

13. Lift the display assembly 2 straight up and remove it.

Removing the Display Assembly
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Removal and Replacement Procedures
Display Assembly Components

Spare Part Number Information

Description
Spare Part 
Number

Display bezel 418889-001

Display panels
14.1-inch, WXGA+
14.1-inch, WXGA

418891-001
418890-001

Display Hinge Kit 418902-001

Display Inverter 418888-001

Wireless Antenna Kit 418899-001

Display enclosure 418895-001

Display Bracket Kit (includes left display bracket)
Display Cable Kit (for use with 14.1-inch, WXGA+ display 
panel)
Display Cable Kit (for use with 14.1-inch, WXGA display panel)
Display Screw Kit
Display Rubber Kit (includes all display bezel rubber and mylar 
screw covers)

418894-001
418898-001

418897-001
418892-001
418893-001
5�48 Maintenance and Service Guide



Removal and Replacement Procedures
14. Remove the following:

1 and 2 four rubber screw covers

✎ The two rubber screw covers 1 on the top edge of the display 
bezel are different from the two rubber screw covers 2 on the 
bottom edge of the display bezel.

Both types of rubber screw covers are included in the Display 
Rubber Kit, spare part number 418893-001.

3 Four Phillips PM2.5×6.0 screws

Removing the Display Bezel Screws
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Removal and Replacement Procedures
15. Flex the insides edges of the left and right sides 1 and the 
top and bottom sides 2 of the display bezel until the bezel 
disengages from the display enclosure.

16. Remove the display bezel 3.

Removing the Display Bezel

Display Assembly Components

Spare Part Number Information

Description
Spare Part 
Number

Display bezel 418889-001

Display enclosure 418895-001
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Removal and Replacement Procedures
17. If it is necessary to replace the display hinges, remove the 
Phillips PM2.5×4.0 screw 1 and the Phillips PM2.5×6.0 
screw 2 that secure each hinge to the display enclosure.

18. Remove the display hinges 3.

Removing the Display Hinges

Display Assembly Components

Spare Part Number Information

Description
Spare Part 
Number

Display Hinge Kit 418902-001
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Removal and Replacement Procedures
19. Remove the four mylar screw covers 1 and the four Phillips 
PM2.0×3.0 screws 2 that secure the display panel to the 
display enclosure.

20. Remove the two Phillips PM2.5×6.0 screws 3 that secure 
the display inverter to the display enclosure.

21. Remove the display panel 4 and display inverter 5 from the 
display enclosure.

Removing the Display Panel

Display Assembly Components

Spare Part Number Information

Description
Spare Part 
Number

Display panels
14.1-inch, WXGA+
14.1-inch, WXGA

418891-001
418890-001
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Removal and Replacement Procedures
22. Disconnect the display 1 and backlight cables 2 from the 
inverter.

23. Remove the inverter 3.

Removing the Display Inverter

Display Assembly Components

Spare Part Number Information

Description
Spare Part 
Number

Display Inverter 418888-001
Maintenance and Service Guide 5�53



Removal and Replacement Procedures
24. If it is necessary to replace the wireless antenna transceivers 
and cables, remove the two Torx T8M2.5×4.0 screws 1 that 
secure the left and right transceivers to the display enclosure.

25. Remove the wireless antenna cables 2 from the clips in the 
display enclosure.

26. Detach the wireless antenna transceivers 3 from the display 
enclosure.

27. Remove the wireless antenna transceivers and cables.

Removing the Wireless Antenna Transceivers and Cables

Reverse the above procedure to reassemble and install the 
display assembly

Display Assembly Components

Spare Part Number Information

Description
Spare Part 
Number

Wireless Antenna Kit 418899-001
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Removal and Replacement Procedures
5.21 Top Cover

1. Prepare the computer for disassembly (Section 5.3), 
and then remove the following components:

a. Keyboard (Section 5.10)

b. Switch cover (Section 5.15)

c. Fan assembly (Section 5.17)

d. Heat sink (Section 5.18)

e. Display assembly (Section 5.20)

2. Turn the computer upside down with the front toward you.

Top Cover Spare Part Number Information

Top cover (includes TouchPad, smart card reader, and 
fingerprint reader board)
Top cover (includes TouchPad and smart card reader)

418882-001

438169-001
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Removal and Replacement Procedures
3. Remove the following:

1 Two rubber screw covers

2 Nine Torx8 T8M2.5×11.0 screws that secure the top cover 
to the base enclosure

3 One Phillips PM2.5×5.0 screw that secures the top cover 
to the base enclosure

Removing the Top Cover Screws, Part 1
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Removal and Replacement Procedures
4. Turn the computer right-side up with the front toward you.

5. Disconnect the following cables from the system board:

1 TouchPad cable 

2 Fingerprint reader board cable

3 Smart card assembly cable

Disconnecting the Top Cover Cables
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Removal and Replacement Procedures
6. Remove the microphone 1 from the clip in the top cover and 
the cable 2 from the routing clips in the top cover.

Releasing the Microphone
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Removal and Replacement Procedures
7. Remove the two Torx8 T8M2.5×7.0 screws that secure the 
top cover to the base enclosure.

Removing the Top Cover Screws, Part 2
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Removal and Replacement Procedures
8. Swing the rear edge of the top cover 1 up and forward 2 
until the left and right sides disengage from the 
base enclosure.

9. Remove the top cover 3.

Removing the Top Cover

Reverse the above procedure to install the top cover.
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Removal and Replacement Procedures
5.22 PC Card/Digital Media Board

1. Prepare the computer for disassembly (Section 5.3), 
and then remove the following components:

a. Keyboard (Section 5.10)

b. Switch cover (Section 5.15)

c. Fan assembly (Section 5.17)

d. Heat sink (Section 5.18)

e. Display assembly (Section 5.20)

f. Top cover (Section 5.21)

PC Card/Digital Media Board

Spare Part Number Information

PC Card/digital media board 418884-001
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Removal and Replacement Procedures
2. Remove the three Phillips PM2.5×5.0 screws 1 that secure 
the PC Card/digital media board to the system board.

3. Lift up on the right side of the PC Card/digital media board 2 
to disconnect the board from the system board.

Removing the PC Card/Digital Media Board
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Removal and Replacement Procedures
4. If it is necessary to remove the PC Card assembly from the 
digital media board, disengage the hooks 1 on the PC Card 
assembly from the tabs on the digital media board.

5. Remove the PC Card assembly 2 from the 
digital media board.

Removing the PC Card Assembly

Reverse the above procedure to reassemble and install the 
PC Card/digital media board.
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Removal and Replacement Procedures
5.23 Speaker

1. Prepare the computer for disassembly (Section 5.3), 
and then remove the following components:

a. Keyboard (Section 5.10)

b. Switch cover (Section 5.15)

c. Fan assembly (Section 5.17)

d. Heat sink (Section 5.18)

e. Display assembly (Section 5.20)

f. Top cover (Section 5.21)

g. PC Card/digital media board (Section 5.22)

Speaker Spare Part Number Information

Speaker 418883-001
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Removal and Replacement Procedures
2. Disconnect the speaker cable 1 from the system board.

3. Remove the speaker 2 from the base enclosure.

Removing the Speaker

Reverse the above procedure to install the speaker.
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Removal and Replacement Procedures
5.24 Microphone

1. Prepare the computer for disassembly (Section 5.3), 
and then remove the following components:

a. Keyboard (Section 5.10)

b. Switch cover (Section 5.15)

c. Fan assembly (Section 5.17)

d. Heat sink (Section 5.18)

e. Display assembly (Section 5.20)

f. Top cover (Section 5.21)

g. PC Card/digital media board (Section 5.22)

Microphone Spare Part Number Information

Microphone 418903-001
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Removal and Replacement Procedures
2. Disconnect the microphone cable 1 from the system board.

3. Remove the microphone 2 from the base enclosure.

Removing the Microphone

Reverse the above procedure to install the microphone.
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Removal and Replacement Procedures
5.25 System Board

✎ When replacing the system board, be sure that the following 
components are removed from the defective system board and 
installed on the replacement system board:
■ Memory modules (Section 5.7 and Section 5.12)
■ Mini Card WLAN module (Section 5.8)
■ RTC battery (Section 5.11)
■ Modem module (Section 5.13)
■ Mini Card WWAN module (Section 5.14)
■ Processor (Section 5.19)

System Board Spare Part Number Information

✎ All system board spare part kits include thermal grease, alcohol pads, 
and thermal pads.

128-MB discrete, for use only with heat sink with spare part 
number 418887-001
64-MB discrete, for use only with heat sink with spare part 
number 418887-001

418904-001

430495-001

UMA, for use only with heat sink with spare part number 
418930-001

418931-001
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Removal and Replacement Procedures
1. Prepare the computer for disassembly (Section 5.3), 
and then remove the following components:

a. Hard drive (Section 5.4)
b. Bluetooth board (Section 5.6)
c. MultiBay II device (Section 5.9)
d. Keyboard (Section 5.10)
e. Switch cover (Section 5.15)
f. Fan assembly (Section 5.17)
g. Heat sink (Section 5.18)
h. Display assembly (Section 5.20)
i. Top cover (Section 5.21)
j. PC Card/digital media board (Section 5.22)
k. Speaker (Section 5.23)
l. Microphone (Section 5.24)
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Removal and Replacement Procedures
2. Turn the computer upside down with the front toward you.

3. Remove the two Phillips PM2.0×6.0 screws on each side of 
the hard drive connector that secure the system board to the 
base enclosure.

Removing the System Board Screws, Part 1
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Removal and Replacement Procedures
4. Turn the computer right-side up with the front toward you.

5. Remove the audio board cables 1 from the space between 
the system board and the base enclosure.

6. Disconnect the audio board cable 2 from the system board.

7. Disconnect the Bluetooth module cable 3 from the 
system board and remove the cable from the base enclosure.

✎ The audio board and Bluetooth module cables are available in 
the Cable Kit, spare part number 418876-001.

Disconnecting the System Board Cables, Part 1
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Removal and Replacement Procedures
8. Disconnect the modem module cable 1 from the 
system board.

✎ The modem module cable is available in the Cable Kit, spare 
part number 418876-001.

9. Release the ZIF connector 2 to which the LED board cable is 
attached and disconnect the LED board cable 3 from the 
system board.

Disconnecting the System Board Cables, Part 2
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Removal and Replacement Procedures
10. Remove the four Phillips PM2.5×5.0 screws that secure the 
system board to the base enclosure.

Removing the System Board Screws, Part 2
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Removal and Replacement Procedures
11. Use the hard drive connector 1 to lift the right side of the 
system board 2 until it rests at an angle.

12. Slide the system board 3 away at an angle and remove it.

Removing the System Board
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Removal and Replacement Procedures
13. If it is necessary to replace the audio cable, disconnect the 
cable from the three connectors on the system board and 
remove the cable.

✎ The audio cable is available in the Cable Kit, spare part number 
418876-001.

Removing the Audio Cable
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Removal and Replacement Procedures
14. If it is necessary to replace the modem connector and cable, 
remove the connector 1 from the clip in the base enclosure 
and remove the cable 2 from the routing channel in the base 
enclosure.

✎ The modem cable is available in the Cable Kit, spare part 
number 418876-001.

Removing the Modem Connector and Cable

Reverse the above procedures to install the system board.
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Removal and Replacement Procedures
5.26 MultiBay II Eject Assembly

1. Prepare the computer for disassembly (Section 5.3), 
and then remove the following components:

a. Hard drive (Section 5.4)

b. Bluetooth board (Section 5.6)

c. MultiBay II device (Section 5.9)

d. Keyboard (Section 5.10)

e. Switch cover (Section 5.15)

f. Fan assembly (Section 5.17)

g. Heat sink (Section 5.18)

h. Display assembly (Section 5.20)

i. Top cover (Section 5.21)

j. PC Card/digital media board (Section 5.22)

k. Speaker (Section 5.23)

l. Microphone (Section 5.24)

m. System board (Section 5.25)

MultiBay II Eject Assembly

Spare Part Number Information

MultiBay II eject assembly 418905-001
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Removal and Replacement Procedures
2. Remove the Phillips PM2.0×6.0 screw 1 that secures the 
MultiBay II eject assembly to the base enclosure.

3. Remove the MultiBay II eject assembly 2 from the base 
enclosure.

Removing the MultiBay II Eject Assembly 

Reverse the above procedure to install the MultiBay II eject 
assembly.
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6
Specifications

This chapter provides physical and performance specifications.

Table 6-1

Computer

Dimensions Metric U.S.

Height (front to back)
Width
Depth

2.9 to 3.4 cm
33.1 cm
23.9 cm

1.1 to 1.3 in
13.0 in
9.4 in

Weight 2.2 kg 4.9 lbs

Input Power

Operating voltage

Operating current

18.5 V dc @ 3.5 A – 65 W
19.0 V dc @ 4.74 A – 90 W
3.5 A or 4.74 A

Temperature

Operating (not writing to 
optical disc)
Operating (writing to optical disc)
Nonoperating

0°C to 35°C

5°C to 35°C
-20°C to 60°C

32°F to 95°F

41°F to 95°F
-4°F to 140°F
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Specifications
Relative humidity (noncondensing)

Operating
Nonoperating

10% to 90%
5% to 95%

10% to 90%
5% to 95%

Maximum altitude (unpressurized)

Operating (14.7 to 10.1 psia)
Nonoperating (14.7 to 4.4 psia)

-15 m to 3,048 m
-15 m to 12,192 m

-50 ft to 10,000 ft
-50 ft to 40,000 ft

Shock

Operating
Nonoperating

125 g, 2 ms, half-sine
200 g, 2 ms, half-sine

Random Vibration

Operating

Nonoperating

0.75 g zero-to-peak, 10 Hz to 500 Hz, 
0.25 oct/min sweep rate
1.50 g zero-to-peak, 10 Hz to 500 Hz, 
0.5 oct/min sweep rate

✎ Applicable product safety standards specify thermal limits for plastic 
surfaces. The computer operates well within this range of temperatures.

Table 6-1

Computer (Continued)
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Specifications
Table 6-2

14.1-inch, WXGA

Dimensions

Height
Width
Diagonal

21.3 cm
28.5 cm
35.8 cm

8.4 in
11.2in
14.1 in

Number of colors Up to 16.8 million

Contrast ratio 250:1

Brightness 180 nits typical

Pixel resolution

Pitch
Format
Configuration

0.279 × 0.279 mm
1024 × 768
RGB vertical stripe

Backlight Edge lit

Character display 80 × 25

Total power consumption 4.0 W

Viewing angle +/-40° horizontal, +120/-40° vertical 
typical
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Specifications
Table 6-3

Hard Drives

120-GB* 100-GB* 80-GB*

Dimensions

Height
Width
Weight

9.5 mm
70 mm
99 g

9.5 mm
70 mm
99 g

9.5 mm
70 mm
99 g

Interface type SATA SATA SATA

Transfer rate

Synchronous 
(maximum)
Security

150 MB/sec
ATA
security

150 MB/sec
ATA
security

100 MB/sec

ATA security

Seek times (typical read, including setting)

Single track
Average
Maximum

2 ms
12 ms
22 ms

1.5 ms
10.5 ms
22 ms

1 ms
10 ms
18 ms

Logical blocks† 234,441,648 195,371,568 156.301.488

Disc rotational 
speed

5400 rpm 7200 rpm 7200 rpm

Operating 
temperature

0°C to 60°C 
(32°F to 
140°F)

5°C to 55°C (41°F to 
131°F)

✎  Certain restrictions and exclusions apply. For details, consult technical 
support by selecting Start > Help and Support > Contact support.

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual 
accessible capacity is less.
†Actual drive specifications may differ slightly.
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Specifications
100-GB* 80-GB* 60-GB* 40-GB*

Dimensions

Height
Width
Weight

9.5 mm
70 mm
99 g

9.5 mm
70 mm
99 g

9.5 mm
70 mm
99 g

9.5 mm
70 mm
99 g

Interface type SATA SATA SATA SATA

Transfer rate

Synchronous 
(maximum)
Security

100 MB/sec
ATA
security

100 MB/sec
ATA 
security

100 MB/sec
ATA
security

100 MB/sec
ATA 
security

Seek times (typical read, including setting)

Single track
Average
Maximum

3 ms
13 ms
24 ms

3 ms
13 ms
24 ms

3 ms
13 ms
24 ms

3 ms
13 ms
24 ms

Logical blocks† 195,363,650 156,301,488 117,210,240 78,140,160

Disc rotational 
speed

5400 rpm 5400 rpm 7200 and 
5400 rpm

5400 rpm

Operating 
temperature

5°C to 55°C (41°F to 131°F)

✎  Certain restrictions and exclusions apply.For details, consult technical 
support by selecting Start > Help and Support > Contact support.

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual 
accessible capacity is less.
†Actual drive specifications may differ slightly.

Table 6-3

Hard Drives
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Specifications
Table 6-4

DVD±RW and CD-RW Combo Drive

Applicable disc Read:
DVD-R, DVD-RW, 
DVD-ROM (DVD-5, DVD-9, 
DVD-10, DVD-18),
CD-ROM (Mode 1 and 2)
CD Digital Audio
CD-XA ready (Mode 2, Form 
1 and 2)
CD-I ready (Mode 2, Form 1 
and 2)
CD-R, CD-RW
Photo CD (single and 
multisession)
CD-Bridge

Write:
CD-R and CD-RW
DVD-R and 
DVD-RW

Center hole diameter 1.5 cm (0.59 in)

Disc diameter

Standard disc
Mini disc

12 cm (4.72 in)
8 cm (3.15 in)
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Specifications
Disc thickness 1.2 mm (0.047 in)

Track pitch 0.74 µm

Access time CD DVD

Random
Full stroke

< 175 ms
< 285 ms

< 230 ms
< 335 ms

Audio output level Audio-out, 0.7 Vrms

Cache buffer 2 MB

Data transfer rate

CD-R (16X)
CD-RW (8X)
CD-ROM (24X)
DVD (8X)
DVD-R (4X)
DVD-RW (2X)
Multiword DMA mode 2

2,400 KB/s (150 KB/s at 1X CD rate)
1,200 KB/s (150 KB/s at 1X CD rate)
3,600 KB/s (150 KB/s at 1X CD rate)
10,800 KB/s (1,352 KB/s at 1X DVD rate)
5,400 KB/s (1,352 KB/s at 1X DVD rate)
2,700 KB/s (1,352 KB/s at 1X DVD rate)
16.6 MB/s

Startup time < 15 seconds

Stop time < 6 seconds

Table 6-4

DVD±RW and CD-RW Combo Drive (Continued)
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Specifications
Table 6-5

DVD-ROM Drive

Applicable disc DVD-ROM (DVD-5, DVD-9, DVD-10, DVD-18)
CD-ROM (Mode 1 and 2)
CD Digital Audio
CD-XA ready (Mode 2, Form 1 and 2)
CD-I ready (Mode 2, Form 1 and 2)
CD-R
CD-RW
Photo CD (single and multisession)
CD-Bridge

Center hole diameter 1.5 cm (0.59 in)

Disc diameter

Standard disc
Mini disc

12 cm (4.72 in)
8 cm (3.15 in)

Disc thickness 1.2 mm (0.047 in)

Track pitch 0.74 µm

Access time CD DVD

Random
Full stroke

< 100 ms
< 175 ms

< 125 ms
< 225 ms

Audio output level Line-out, 0.7 Vrms

Cache buffer 512 KB

Data transfer rate

CD-R (24X)
CD-RW (10X)
CD-ROM (24X)
DVD (8X)
Multiword DMA mode 2

3,600 KB/s (150 KB/s at 1X CD rate)
1,500 KB/s (150 KB/s at 1X CD rate)
3,600 KB/s (150 KB/s at 1X CD rate)
10,800 KB/s (1,352 KB/s at 1X DVD rate)
16.6 MB/s

Startup time < 10 seconds

Stop time < 3 seconds
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Specifications
Table 6-6

System DMA

Hardware DMA System Function

DMA0 Not applicable

DMA1* Not applicable

DMA2* Not applicable

DMA3 Not applicable

DMA4 Direct memory access controller

DMA5* Available for PC Card

DMA6 Not assigned

DMA7 Not assigned

*PC Card controller can use DMA 1, 2, or 5.
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Specifications
Table 6-7

System Interrupts

Hardware IRQ System Function

IRQ0 System timer

IRQ1 Standard 101-/102-Key or Microsoft Natural Keyboard

IRQ2 Cascaded

IRQ3 Intel 82801DB/DBM USB2 Enhanced Host 
Controller—24CD

IRQ4 COM1

IRQ5* Conexant AC—Link Audio
Intel 82801DB/DBM SMBus Controller—24C3
Data Fax Modem with SmartCP 

IRQ6 Diskette drive

IRQ7* Parallel port

IRQ8 System CMOS/real-time clock

IRQ9* Microsoft ACPI-compliant system

IRQ10* Intel USB UHCI controller—24C2
Intel 82852/82855 GM/GME Graphic Controller
Realtek RTL8139 Family PCI fast Ethernet Controller

✎ PC Cards may assert IRQ3, IRQ4, IRQ5, IRQ7, IRQ9, IRQ10, IRQ11, or 
IRQ15. Either the infrared or the serial port may assert IRQ3 or IRQ4.
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Specifications
IRQ11 Intel USB EHCI controller—24CD
Intel USB UHCI controller—24C4
Intel USB UHCI controller—24C7
Intel Pro/Wireless 2200BG
TI OHCI 1394 host controller
TI PCI1410 CardBus controller

IRQ12 Synaptics PS/2 TouchPad

IRQ13 Numeric data processor

IRQ14 Primary IDE channel

IRQ15 Secondary IDE channel

*Default configuration; audio possible configurations are IRQ5, IRQ7, IRQ9, 
IRQ10, or none.

✎ PC Cards may assert IRQ3, IRQ4, IRQ5, IRQ7, IRQ9, IRQ10, IRQ11, or 
IRQ15. Either the infrared or the serial port may assert IRQ3 or IRQ4.

Table 6-7

System Interrupts (Continued)
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Specifications
Table 6-8

System I/O Addresses

I/O Address (hex) System Function (shipping configuration)

000 - 00F DMA controller no. 1

010 - 01F Unused

020 - 021 Interrupt controller no. 1

022 - 024 Opti chipset configuration registers

025 - 03F Unused

02E - 02F 87334 “Super I/O” configuration for CPU

040 - 05F Counter/timer registers

044 - 05F Unused

060 Keyboard controller

061 Port B

062 - 063 Unused

064 Keyboard controller

065 - 06F Unused

070 - 071 NMI enable/RTC

072 - 07F Unused

080 - 08F DMA page registers

090 - 091 Unused

092 Port A

093 - 09F Unused

0A0 - 0A1 Interrupt controller no. 2
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Specifications
I/O Address (hex) System Function (shipping configuration)

0A2 - 0BF Unused

0C0 - 0DF DMA controller no. 2

0E0 - 0EF Unused

0F0 - 0F1 Coprocessor busy clear/reset

0F2 - 0FF Unused

100 - 16F Unused

170 - 177 Secondary fixed disk controller

178 - 1EF Unused

1F0 - 1F7 Primary fixed disk controller

1F8 - 200 Unused

201 JoyStick (decoded in ESS1688)

202 - 21F Unused

220 - 22F Entertainment audio

230 - 26D Unused

26E - 26 Unused

278 - 27F Unused

280 - 2AB Unused

2A0 - 2A7 Unused

2A8 - 2E7 Unused

2E8 - 2EF Reserved serial port

Table 6-8

System I/O Addresses (Continued)
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Specifications
I/O Address (hex) System Function (shipping configuration)

2F0 - 2F7 Unused

2F8 - 2FF Infrared port

300 - 31F Unused

320 - 36F Unused

370 - 377 Secondary diskette drive controller

378 - 37F Parallel port (LPT1/default)

380 - 387 Unused

388 - 38B FM synthesizer—OPL3

38C - 3AF Unused

3B0 - 3BB VGA

3BC - 3BF Reserved (parallel port/no EPP support)

3C0 - 3DF VGA

3E0 - 3E1 PC Card controller in CPU

3E2 - 3E3 Unused

3E8 - 3EF Internal modem

3F0 - 3F7 “A” diskette controller

3F8 - 3FF Serial port (COM1/default)

CF8 - CFB PCI configuration index register (PCIDIVO-1)

CFC - CFF PCI configuration data register (PCIDIVO-1)

Table 6-8

System I/O Addresses (Continued)
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Specifications
Table 6-9

System Memory Map

Size Memory Address System Function

640 KB 00000000-0009FFFF Base memory

128 KB 000A0000-000BFFFF Video memory

48 KB 000C0000-000CBFFF Video BIOS

160 KB 000C8000-000E7FFF Unused

64 KB 000E8000-000FFFFF System BIOS

15 MB 00100000-00FFFFFF Extended memory

58 MB 01000000-047FFFFF Super extended memory

58 MB 04800000-07FFFFFF Unused

2 MB 08000000-080FFFFF Video memory (direct access)

4 GB 08200000-FFFEFFFF Unused

64 KB FFFF0000-FFFFFFFF System BIOS
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A
 Screw Listing

This appendix provides specification and reference information 
for the screws used in the computer. All screws listed in this 
appendix are available in the Screw Kit, spare part number 
418878-001, and the Display Screw Kit, spare part number 
418892-001.

Phillips PM3.0×3.0 Screw Locations

Table A-1

Phillips PM3.0×3.0 Screw

Color Qty. Length Thread
Head 
Width

Black 4 3.0 mm 3.0 mm 5.0 mm

Where used:
4 screws that secure the hard drive frame to the hard drive (documented in 
Section 5.4)

mm
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Screw Listing
Phillips PM2.0×5.0 Screw Locations

Table A-2

Phillips PM2.0×5.0 Screw

Color Qty. Length Thread
Head 
Width

Black 5 5.0 mm 2.0 mm 5.0 mm

Where used:
1 Two screws that secure the hard drive cover to the computer (screws are 
captured on the cover by C-clips; documented in Section 5.4)
2 One screw that secures the Bluetooth module cover to the computer (screw 
is captured on the cover by a C-clip; documented in Section 5.6)
3 One screw that secures the memory module compartment cover to the 
computer (screw is captured on the cover by a C-clip; documented in
Section 5.7)
4 One screw that secures the Mini Card module compartment cover to the 
computer (screw is captured on the cover by a C-clip; documented in
Section 5.8)

mm
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Screw Listing
Phillips PM2.5×13.0 Screw Location

Table A-3

Phillips PM2.5×13.0 Spring-Loaded Screw

Color Qty. Length Thread
Head 
Width

Silver 1 13.0 mm 2.5 mm 6.0 mm

Where used:
One screw that secures the hard drive to the computer (screw is captured on the 
cover by a C-clip; documented in Section 5.4)

mm
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Screw Listing
Phillips PM2.5×5.0 Screw Location

Table A-4

Phillips PM2.5×5.0 Screw

Color Qty. Length Thread
Head 
Width

Black 9 5.0 mm 2.5 mm 5.0 mm

Where used:
One screw that secures the MultiBay II device to the computer (documented in 
Section 5.9)

mm
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Screw Listing
Phillips PM2.5×5.0 Screw Locations

Table A-4

Phillips PM2.5×5.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 9 5.0 mm 2.5 mm 5.0 mm

Where used:
1 One screw that secures the display assembly to the computer (documented 
in Section 5.20)
2 One screw that secures the top cover to the computer (documented in
Section 5.21)

mm
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Screw Listing
Phillips PM2.5×5.0 Screw Locations

Table A-4

Phillips PM2.5×5.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 9 5.0 mm 2.5 mm 5.0 mm

Where used:
3 screws that secure the PC Card/digital media board to the computer 
(documented in Section 5.22)

mm
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Screw Listing
Phillips PM2.5×5.0 Screw Locations

Table A-4

Phillips PM2.5×5.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 9 5.0 mm 2.5 mm 5.0 mm

Where used:
4 screws that secure the system board to the computer (documented in
Section 5.25)

mm
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Screw Listing
Torx8 T8M2.5×11.0 Screw Locations

Table A-5

Torx8 T8M2.5×11.0 Screw

Color Qty. Length Thread
Head 
Width

Black 16 11.0 mm 2.5 mm 5.0 mm

Where used:
1 Three screws that secure the keyboard to the computer (documented in 
Section 5.10)
2 Two screws that secure the switch cover to the computer (documented in 
Section 5.15)
3 Two screws that secure the display assembly to the computer 
(documented in Section 5.20)

mm
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Screw Listing
Torx8 T8M2.5×11.0 Screw Locations

Table A-5

Torx8 T8M2.5×11.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 16 11.0 mm 2.5 mm 5.0 mm

Where used:
9 screws that secure the top cover to the computer (documented in
Section 5.21)

mm
Maintenance and Service Guide A�9



Screw Listing
Phillips PM2.0×6.0 Screw Locations

Table A-6

Phillips PM2.0×6.0 Screw

Color Qty. Length Thread
Head 
Width

Silver 5 6.0 mm 2.0 mm 5.0 mm

Where used:
2 screws that secure the modem module to the computer (documented in
Section 5.13)

mm
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Screw Listing
Phillips PM2.0×6.0 Screw Locations

Table A-6

Phillips PM2.0×6.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Silver 5 6.0 mm 2.0 mm 5.0 mm

Where used:
2 screws that secure the system board to the computer (documented in
Section 5.25)

mm
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Screw Listing
Phillips PM2.0×6.0 Screw Location

Table A-6

Phillips PM2.0×6.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Silver 5 6.0 mm 2.0 mm 5.0 mm

Where used:
One screw that secures the MultiBay II eject assembly to the base enclosure 
(documented in Section 5.26)

mm
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Screw Listing
Phillips PM2.0×3.0 Screw Locations

Table A-7

Phillips PM2.0×3.0 Screw

Color Qty. Length Thread
Head 
Width

Silver 4 3.0 mm 2.0 mm 5.0 mm

Where used:
2 screws that secure the Mini Card WLAN to the computer (documented in
Section 5.8)

mm
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Screw Listing
Phillips PM2.0×3.0 Screw Locations

Table A-7

Phillips PM2.0×3.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Silver 4 3.0 mm 2.0 mm 5.0 mm

Where used:
2 screws that secure the Mini Card WWAN to the computer (documented in
Section 5.14)

mm
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Screw Listing
Phillips PM2.5×4.0 Screw Locations

Table A-8

Phillips PM2.5×4.0 Screw

Color Qty. Length Thread
Head 
Width

Silver 4 4.0 mm 2.5 mm 5.0 mm

Where used:
2 screws that secure the power button board to the switch cover (documented in
Section 5.16)

mm
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Screw Listing
Phillips PM2.5×4.0 Screw Locations

Table A-8

Phillips PM2.5×4.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Silver 4 4.0 mm 2.5 mm 5.0 mm

Where used:
2 screws that secure the display hinges to the display assembly (documented in
Section 5.20)

mm
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Screw Listing
Torx8 T8M2.5×4.0 Screw Locations

Table A-9

Torx8 T8M2.5×4.0 Screw

Color Qty. Length Thread
Head 
Width

Silver 2 4.0 mm 2.5 mm 5.0 mm

Where used:
2 screws that secure the wireless antenna transceivers to the display assembly 
(documented in Section 5.20)

mm
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Screw Listing
Phillips PM2.5×10.0 and Phillips PM2.5×13.0 Screw Locations

Table A-10

Phillips PM2.5×10.0 Screw

Color Qty. Length Thread
Head 
Width

Silver 4 10.0 mm 2.5 mm 6.0 mm

Where used:
1 Four screws that secure the heat sink to the computer (screws are secured 
to the heat sink by C-clips; documented in Section 5.18)

Table A-11

Phillips PM2.5×13.0 Screw

Color Qty. Length Thread
Head 
Width

Silver 2 13.0 mm 2.5 mm 6.0 mm

Where used:
2 Two screws that secure the heat sink to the computer (screws are secured 
to the heat sink by C-clips; documented in Section 5.18)

mm

mm
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Screw Listing
Phillips PM2.0×2.0 Screw Locations

Table A-12

Phillips PM2.0×2.0 Screw

Color Qty. Length Thread
Head 
Width

Black 4 2.0 mm 2.0 mm 6.0 mm

Where used:
4 screws that secure the switch cover to the computer (documented in
Section 5.15)

mm
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Screw Listing
Torx8 T8M2.5×7.0 Screw Location

Table A-13

Torx8 T8M2.5×7.0 Screw

Color Qty. Length Thread
Head 
Width

Black 8 7.0 mm 2.5 mm 5.0 mm

Where used:
One screw that secures the fan assembly to the computer (documented in 
Section 5.17)

mm
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Screw Listing
Torx8 T8M2.5×7.0 Screw Locations

Table A-13

Torx8 T8M2.5×7.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 8 7.0 mm 2.5 mm 5.0 mm

Where used:
2 screws that secure the display assembly to the computer (documented in 
Section 5.20)

mm
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Screw Listing
Torx8 T8M2.5×7.0 Screw Locations

Table A-13

Torx8 T8M2.5×7.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 8 7.0 mm 2.5 mm 5.0 mm

Where used:
2 screws that secure the display assembly to the computer (documented in 
Section 5.20)

mm
A�22 Maintenance and Service Guide



Screw Listing
Torx8 T8M2.5×7.0 Screw Location

Table A-13

Torx8 T8M2.5×7.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 8 7.0 mm 2.5 mm 5.0 mm

Where used:
One screw that secures the top cover to the computer (documented in
Section 5.21)

mm
Maintenance and Service Guide A�23



Screw Listing
Torx8 T8M2.5×7.0 Screw Locations

Table A-13

Torx8 T8M2.5×7.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 8 7.0 mm 2.5 mm 5.0 mm

Where used:
2 screws that secure the top cover to the computer (documented in
Section 5.21)

mm
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Screw Listing
Phillips PM2.5×6.0 Screw Locations

Table A-14

Phillips PM2.5×6.0 Screw

Color Qty. Length Thread
Head 
Width

Silver 8 6.0 mm 2.5 mm 5.0 mm

Where used:
4 screws that secure the display bezel to the display assembly (documented in
Section 5.20)

mm
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Screw Listing
Phillips PM2.5×6.0 Screw Locations

Table A-14

Phillips PM2.5×6.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Silver 8 6.0 mm 2.5 mm 5.0 mm

Where used:
2 screws that secure the display hinges to the display assembly (documented in
Section 5.20)

mm
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Screw Listing
Phillips PM2.5×6.0 Screw Locations

Table A-14

Phillips PM2.5×6.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Silver 8 6.0 mm 2.5 mm 5.0 mm

Where used:
2 screws that secure the display panel to the display assembly (documented in
Section 5.20)

mm
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B
Backup and Recovery in

Windows Vista

✎ You can only recover files that you have previously backed up. 
HP recommends that you use HP Backup & Recovery Manager 
to create an entire drive backup as soon as you set up your 
computer.

With HP Backup & Recovery Manager, you can perform the 
following tasks:

■ Backing up your information regularly to protect your 
important system files

■ Creating system recovery points that allow you to reverse 
undesirable changes to your computer by restoring the 
computer to an earlier state

■ Scheduling backups at specific intervals or events

When to Back Up
■ On a regularly scheduled basis

✎ Set reminders to back up your information periodically.

■ Before the computer is repaired or restored

■ Before you add or modify hardware or software
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Backup and Recovery in Windows Vista
Backup Suggestions
■ Create a set of recovery discs using HP Backup & Recovery 

Manager.

■ Create system recovery points using HP Backup & Recovery 
Manager, and periodically copy them to disc.

■ Store personal files in the Documents folder and back up 
these folders periodically.

■ Back up templates stored in their associated programs.

■ Save customized settings in a window, toolbar, or menu bar 
by taking a screen shot of your settings.

The screen shot can be a time saver if you have to reset 
your preferences.

To copy the screen and paste it into a word-processing 
document:

a. Display the screen.

b. Copy the screen.

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

c. Open a word-processing document, and then select 
Edit > Paste.

✎ Before you can perform backup and recovery procedures, the 
computer must be connected to external power.

✎ Drivers, utilities, and applications installed by HP can be 
copied to a CD or to a DVD using HP Backup & Recovery 
Manager.
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Backup and Recovery in Windows Vista
Backing Up Specific Files or Folders
You can back up specific files or folders to the recovery partition 
on the hard drive, to an optional external hard drive, or to optical 
discs (CDs or DVDs).

✎ This process will take several minutes, depending on the file 
size and the speed of the computer.

To back up specific files or folders:

1. Select Start > All Programs > HP Backup & Recovery > 
Backup and Recovery Manager.

2. Click Next.

3. Click Back up to protect system settings and important 
data files, and then click Next.

4. Click Back up individual files and folders, and then click 
Next.

5. Follow the on-screen instructions.

Backing up the Entire Hard Drive
When you perform a complete backup of the hard drive, you are 
saving the full factory image, including the Windows® operating 
system, software applications, and all personal files and folders.

✎ A copy of the entire hard drive image can be stored on another 
hard drive, on a network drive, or on recovery discs that you 
create.

✎ This process may take over an hour, depending on your 
computer speed and the amount of data being stored.
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Backup and Recovery in Windows Vista
To back up your entire hard drive:

1. Select Start > All Programs > HP Backup & Recovery > 
Backup and Recovery Manager.

2. Click Next.

3. Click Back up to protect system settings and important 
data files, and then click Next.

4. Click Back up entire hard drive, and then click Next.

5. Follow the on-screen instructions.

Creating Recovery Points
When you back up modifications since your last backup, you are 
creating system recovery points. This allows you to save a 
snapshot of your hard drive at a specific point in time. You can 
then recover back to that point if you want to reverse subsequent 
changes made to your system.

✎ The first system recovery point, a snapshot of the entire image, 
is automatically created the first time you perform a backup. 
Subsequent recovery points make copies of changes made after 
that time.

HP recommends that you create recovery points at the following 
times:

■ Before you add or extensively modify software or hardware

■ Periodically, whenever the system is performing optimally

✎ Recovering to an earlier recovery point does not affect data 
files or e-mails created since that recovery point.

To create a system recovery point:

1. Select Start > All Programs > HP Backup & Recovery > 
Backup and Recovery Manager.

2. Click Next.
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Backup and Recovery in Windows Vista
3. Click Back up to protect system settings and important 
data files, and then click Next.

4. Click Create or manage Recovery Points, and then click 
Next.

5. Follow the on-screen instructions.

Scheduling Backups
Use HP Backup Scheduler to schedule backups for the entire 
system, for recovery points, or for specific files and folders. With 
this tool, you can schedule backups at specific intervals (daily, 
weekly, or monthly) or at specific events, such as at system 
restart or when you dock to an optional docking station (select 
models only).

To schedule backups:

1. Select Start > All Programs > HP Backup & Recovery > 
HP Backup Scheduler.

2. Follow the on-screen instructions.

Performing a Recovery

✎ You can only recover files that you have previously backed up. 
HP recommends that you use HP Backup and Recovery 
Manager to create an entire drive backup as soon as you set up 
your computer.
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Backup and Recovery in Windows Vista
HP Backup and Recovery Manager helps you with the following 
tasks for safeguarding your information and restoring it in case of 
a system failure:

■ Recovering important files—This feature helps you reinstall 
important files without performing a full system recovery.

■ Performing a full system recovery—With HP Backup and 
Recovery Manager, you can recover your full factory image 
if you experience system failure or instability. HP Backup 
and Recovery Manager works from a dedicated recovery 
partition on the hard drive or from recovery discs you create.

Performing a Recovery from the Recovery 
Discs

To perform a recovery from the recovery discs, follow these 
steps:

1. Back up all personal files.

2. Insert the first recovery disc into the optical drive and restart 
the computer.

3. Follow the on-screen instructions.

Performing a Recovery from the Hard Drive
There are 2 ways to initiate a recovery from the hard drive:

■ From within Windows

■ From the recovery partition

Initiating a Recovery in Windows
To initiate a recovery in Windows, follow these steps:

1. Back up all personal files.

2. Select Start > All Programs > HP Backup & Recovery > 
Backup and Recovery Manager.

3. Click Next.
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Backup and Recovery in Windows Vista
4. Click Recover important files or the entire system, and 
then click Next.

5. Follow the on-screen instructions.

Initiating a Recovery from the Hard Drive 
Recovery Partition

To initiate a recovery from the hard drive recovery partition, 
follow these steps:

1. Back up all personal files.

2. Restart the computer, and then press f11 before the Windows 
operating system loads.

3. Click a recovery option, and then click Next.

4. Follow the on-screen instructions.
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C
Backup and Recovery in

Windows XP

Creating Recovery Discs
After setting up the computer for the first time, be sure to create a 
set of recovery discs of the full factory image. The recovery discs 
are used to start up (boot) the computer and recover the operating 
system and software to factory settings in case of system 
instability or failure.

Note the following guidelines before creating recovery discs:

■ You will need high-quality CD-R, DVD-R, or DVD+R 
media (purchased separately).

✎ Formatted DVD±RW discs and DVD±RW double-layer 
discs are not compatible with HP Backup and Recovery 
Manager.

■ The computer must be connected to AC power during the 
process.

■ Only one set of the recovery discs can be created per 
computer.

■ Number each disc before inserting it into the optical drive of 
the computer.

■ If necessary, you can cancel the disc creation before you have 
finished creating the recovery discs. The next time you select 
Create factory software recovery CDs or DVDs to recover 
the system (Highly recommended), you will be prompted to 
continue the disc creation.
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Backup and Recovery in Windows XP
To create a set of recovery discs:

1. Select Start > All Programs > HP Backup & Recovery > 
HP Backup and Recovery Manager.

2. Click Next.

3. Click Create factory software recovery CDs or DVDs to 
recover the system (Highly recommended), and then click 
Next.

4. Follow the on-screen instructions.

Backing Up Your information

✎ You can only recover files that you have previously backed up. 
HP recommends that you use HP Backup and Recovery 
Manager to create an entire drive backup as soon as you set up 
your computer.

With HP Backup and Recovery Manager, you can perform the 
following tasks:

■ Backing up your information regularly to protect your 
important system files

■ Creating system recovery points that allow you to reverse 
undesirable changes to your computer by restoring the 
computer to an earlier state

■ Scheduling backups at specific intervals or events

When to Back Up
■ On a regularly scheduled basis

✎ Set reminders to back up your information periodically.

■ Before the computer is repaired or restored

■ Before you add or modify hardware or software
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Backup and Recovery in Windows XP
Backup Suggestions
■ Create a set of recovery discs using HP Backup and Recovery 

Manager.

■ Create system recovery points using HP Backup and 
Recovery Manager, and periodically copy them to disc.

■ Store personal files in the My Documents folder and back up 
these folders periodically.

■ Back up templates stored in their associated programs.

■ Save customized settings in a window, toolbar, or menu bar 
by taking a screen shot of your settings.

The screen shot can be a time saver if you have to reset your 
preferences.

To copy the screen and paste it into a word-processing 
document:

a. Display the screen.

b. Copy the screen.

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

c. Open a word-processing document, and then select Edit > 
Paste.

✎ Before you can perform backup and recovery procedures, the 
computer must be connected to external power.

✎ Drivers, utilities, and applications installed by HP can be 
copied to a CD or to a DVD using HP Backup and Recovery 
Manager.
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Backup and Recovery in Windows XP
Backing Up Specific Files or Folders
You can back up specific files or folders to the recovery partition 
on the hard drive, to an optional external hard drive, or to optical 
discs (CDs or DVDs).

✎ This process will take several minutes, depending on the file 
size and the speed of the computer.

To back up specific files or folders:

1. Select Start > All Programs > HP Backup & Recovery > 
HP Backup and Recovery Manager.

2. Click Next.
3. Click Back up to protect system settings and important 

data files, and then click Next.
4. Click Back up individual files and folders, and then click 

Next.
5. Follow the on-screen instructions.

Backing Up the Entire Hard Drive
When you perform a complete backup of the hard drive, you are 
saving the full factory image, including the Windows® operating 
system, software applications, and all personal files and folders.

✎ A copy of the entire hard drive image can be stored on another 
hard drive, on a network drive, or on recovery discs that you 
create.

✎ This process may take over an hour, depending on your 
computer speed and the amount of data being stored.

To back up your entire hard drive:

1. Select Start > All Programs > HP Backup & Recovery > 
HP Backup and Recovery Manager.
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Backup and Recovery in Windows XP
2. Click Next.

3. Click Back up to protect system settings and important 
data files, and then click Next.

4. Click Back up entire hard drive, and then click Next.

5. Follow the on-screen instructions.

Creating Recovery Points

When you back up modifications since your last backup, you are 
creating system recovery points. This allows you to save a 
snapshot of your hard drive at a specific point in time. You can 
then recover back to that point if you want to reverse subsequent 
changes made to your system.

✎ The first system recovery point, a snapshot of the entire image, 
is automatically created the first time you perform a backup. 
Subsequent recovery points make copies of changes made after 
that time.

HP recommends that you create recovery points at the following 
times:

■ Before you add or extensively modify software or hardware

■ Periodically, whenever the system is performing optimally

✎ Recovering to an earlier recovery point does not affect data 
files or e-mails created since that recovery point.

To create a system recovery point:

1. Select Start > All Programs > HP Backup & Recovery > 
HP Backup and Recovery Manager.

2. Click Next.

3. Click Back up to protect system settings and important 
data files, and then click Next.
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Backup and Recovery in Windows XP
4. Click Create or manage Recovery Points, and then click 
Next.

5. Follow the on-screen instructions.

Scheduling Backups
Use HP Backup Scheduler to schedule backups for the entire 
system, for recovery points, or for specific files and folders. With 
this tool, you can schedule backups at specific intervals (daily, 
weekly, or monthly) or at specific events, such as at system 
restart or when you dock to an optional docking station (select 
models only).

To schedule backups:

1. Select Start > All Programs > HP Backup & Recovery > 
HP Backup Scheduler.

2. Follow the on-screen instructions.

Performing a Recovery

✎ You can only recover files that you have previously backed up. 
HP recommends that you use HP Backup and Recovery 
Manager to create an entire drive backup as soon as you set up 
your computer.

HP Backup and Recovery Manager helps you with the following 
tasks for safeguarding your information and restoring it in case of 
a system failure:

■ Recovering important files—This feature helps you reinstall 
important files without performing a full system recovery.

■ Performing a full system recovery—With HP Backup and 
Recovery Manager, you can recover your full factory image 
if you experience system failure or instability. HP Backup 
and Recovery Manager works from a dedicated recovery 
partition on the hard drive or from recovery discs you create.
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Backup and Recovery in Windows XP
Performing a Recovery from the Recovery 
Discs

To perform a recovery from the recovery discs, follow these 
steps:

1. Back up all personal files.

2. Insert the first recovery disc into the optical drive and restart 
the computer.

3. Follow the on-screen instructions.

Performing a Recovery from the Hard Drive
There are 2 ways to initiate a recovery from the hard drive:

■ From within Windows

■ From the recovery partition

Initiating a Recovery in Windows
To initiate a recovery in Windows, follow these steps:

1. Back up all personal files.

2. Select Start > All Programs > HP Backup & Recovery > 
HP Backup and Recovery Manager.

3. Click Next.

4. Click Recover important files or the entire system, and 
then click Next.

5. Follow the on-screen instructions.
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Backup and Recovery in Windows XP
Initiating a Recovery from the Hard Drive 
Recovery Partition

To initiate a recovery from the hard drive recovery partition, 
follow these steps:

1. Back up all personal files.

2. Restart the computer, and then press f11 before the Windows 
operating system loads.

3. Click a recovery option, and then click Next.

4. Follow the on-screen instructions.
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D
Display Component Recycling

Å
WARNING: The backlight contains mercury. Caution should be 
exercised when removing and handling the backlight to avoid 
damaging this component and causing exposure to the mercury.

Ä
CAUTION: The procedures in this appendix can result in damage to 
display components. The only components intended for recycling 
purposes are the liquid crystal display (LCD) panel and the backlight. 
Careful handling should be exercised when removing these 
components.

✎ Materials Disposal
This HP product contains mercury in the backlight in the display 
assembly that might require special handling at end-of-life.

Disposal of mercury may be regulated because of environmental 
considerations. For disposal or recycling information, contact 
your local authorities or the Electronic Industries Alliance (EIA) 
at http://www.eiae.org.
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Display Component Recycling
This appendix provides disassembly instructions for the display 
assembly. The display assembly must be disassembled to gain 
access to the backlight 1 and the liquid crystal display (LCD) 
panel 2.

✎ Disassembly procedures differ from one display assembly to 
another. The procedures provided in this appendix are general 
disassembly instructions. Specific details, such as screw sizes, 
quantities, and locations, and component shapes and sizes, can 
vary from one computer model to another.
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Display Component Recycling
Perform the following steps to disassemble the display assembly:

1. Remove all screw covers 1 and screws 2 that secure the 
display bezel to the display assembly.

Removing the Display Bezel Screw Covers and Screws
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Display Component Recycling
2. Lift up and out on the left and right inside edges 1 and the 
top and bottom inside edges 2 of the display bezel until 
the bezel disengages from the display assembly.

3. Remove the display bezel 3.

Removing the Display Bezel
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4. Disconnect all display panel cables 1 from the display 
inverter and remove the inverter 2.

Removing the Display Inverter
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5. Remove all screws 1 that secure the display panel assembly 
to the display enclosure.

6. Remove the display panel assembly 2 from the display 
enclosure.

Removing the Display Panel Assembly
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7. Turn the display panel assembly upside down.

8. Remove all screws that secure the display panel frame to the 
display panel.

Removing the Display Panel Frame Screws
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9. Use a sharp-edged tool to cut the tape 1 that secures the sides 
of the display panel to the display panel frame.

10. Remove the display panel frame 2 from the display panel.

Removing the Display Frame
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11. Remove the screws 1 that secure the backlight cover to the 
display panel.

12. Lift the top edge of the backlight cover 2 and swing it 
forward.

13. Remove the backlight cover.

Removing the Backlight Cover
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14. Turn the display panel right-side up.

15. Remove the backlight cables 1 from the clip 2 in the 
display panel.

Releasing the Backlight Cables
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16. Turn the display panel upside down.

17. Remove the backlight frame from the display panel.

Removing the Backlight Frame
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Å
WARNING: The backlight contains mercury. Caution should be 
exercised when removing and handling the backlight to avoid 
damaging this component and causing exposure to the mercury.

18. Slide the backlight out of the backlight frame.

Removing the Backlight
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19. Disconnect the display cable 1 from the LCD panel.

20. Remove the screws 2 that secure the LCD panel to the 
display rear panel.

21. Release the LCD panel 3 from the display rear panel.

22. Release the tape 4 that secures the LCD panel to the display 
rear panel.

Releasing the LCD Panel
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23. Remove the LCD panel.

Removing the LCD Panel

24. Recycle the LCD panel and backlight.
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E
Connector Pin Assignments

Table D-1

Audio-Out (Headphone)

Pin Signal Pin Signal

1 Audio out, left channel 3 Ground

2 Audio out, right channel
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Connector Pin Assignments
Table D-2

Audio-In (Microphone)

Pin Signal Pin Signal

1 Audio signal in 3 Ground

2 Audio signal in

Table D-3

Universal Serial Bus

Pin Signal Pin Signal

1 +5 VDC 3 Data +

2 Data – 4 Ground
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Connector Pin Assignments
Table D-4

S-Video-Out

Pin Signal Pin Signal

1 S-VHS color (C) signal 5 TV-CD

2 Composite video signal 6 S-VHS intensity ground

3 S-VHS intensity (Y) signal 7 Composite video ground

4 S-VHS color ground
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Connector Pin Assignments
Table D-5

External Monitor

Pin Signal Pin Signal

1 Red analog 9 +5 VDC

2 Green analog 10 Ground

3 Blue analog 11 Monitor detect

4 Not connected 12 DDC 2B data

5 Ground 13 Horizontal sync

6 Ground analog 14 Vertical sync

7 Ground analog 15 DDC 2B clock

8 Ground analog
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Table D-6

RJ-11 (Modem)

Pin Signal Pin Signal

1 Unused 4 Unused

2 Tip 5 Unused

3 Ring 6 Unused
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Table D-7

RJ-45 (Network)

Pin Signal Pin Signal

1 Transmit + 5 Unused

2 Transmit – 6 Receive –

3 Receive + 7 Unused

4 Unused 8 Unused
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F
Power Cord Set Requirements

3-Conductor Power Cord Set
The wide range input feature of the computer permits it to operate 
from any line voltage from 100 to 120 or 220 to 240 volts AC.

The power cord set included with the computer meets the 
requirements for use in the country or region where the 
equipment is purchased.

Power cord sets for use in other countries or regions must meet 
the requirements of the country or region where the computer is 
used.
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Power Cord Set Requirements
General Requirements
The requirements listed below are applicable to all countries or 
regions.

■ The length of the power cord set must be at least 1.5 m 
(5.0 ft) and a maximum of 2.0 m (6.5 ft).

■ All power cord sets must be approved by an acceptable 
accredited agency responsible for evaluation in the country or 
region where the power cord set will be used.

■ The power cord sets must have a minimum current capacity 
of 10 amps and a nominal voltage rating of 125 or 250 V AC, 
as required by each country or region’s power system.

■ The appliance coupler must meet the mechanical 
configuration of an EN 60 320/IEC 320 Standard Sheet C13 
connector for mating with the appliance inlet on the back of 
the computer.
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Power Cord Set Requirements
Country/Region-Specific Requirements

3-Conductor Power Cord Set Requirements

Country/Region Accredited Agency Applicable Note Number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

✎ NOTES:

1. The flexible cord must be <HAR> Type HO5VV-F, 3-conductor, 1.0 mm² 

conductor size. Power cord set fittings (appliance coupler and wall plug) 
must bear the certification mark of the agency responsible for evaluation 
in the country or region where it will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 
3-conductor. The wall plug must be a two-pole grounding type with a 
NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark 
and registration number in accordance with the Japanese Dentori Law. The 
flexible cord must be Type VCT or VCTF, 3-conductor, 1.00 mm² conductor 
size. The wall plug must be a two-pole grounding type with a Japanese 
Industrial Standard C8303 (7 A, 125 V) configuration.
Maintenance and Service Guide F�3



Power Cord Set Requirements
Korea EK 4

The Netherlands KEMA 1

Norway NEMKO 1

People’s Republic 
of China

CCC 5

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

United Kingdom BSI 1

United States UL 2

✎ NOTES:

1. The flexible cord must be <HAR> Type HO5VV-F, 3-conductor, 1.0 mm² 

conductor size. Power cord set fittings (appliance coupler and wall plug) 
must bear the certification mark of the agency responsible for evaluation 
in the country or region where it will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 
3-conductor. The wall plug must be a two-pole grounding type with a 
NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark 
and registration number in accordance with the Japanese Dentori Law. The 
flexible cord must be Type VCT or VCTF, 3-conductor, 1.00 mm² conductor 
size. The wall plug must be a two-pole grounding type with a Japanese 
Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75 mm² conductor size. 
Power cord set fittings (appliance coupler and wall plug) must bear 
the certification mark of the agency responsible for evaluation in the country 
or region where it will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75 mm² conductor 
size. Power cord set fittings (appliance coupler and wall plug) must bear the 
certification mark of the agency responsible for evaluation in the country or 
region where it will be used.

3-Conductor Power Cord Set Requirements (Continued)

Country/Region Accredited Agency Applicable Note Number
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Index

A
AC adapter, spare part 

numbers 3–21, 3–27
accessory battery connector 

1–22
arrow keys 1–15
audio cable

illustrated 3–19
removal 5–71

audio troubleshooting 2–25
audio-in jack

location 1–11
pin assignments E–2

audio-out jack
location 1–11
pin assignments E–1

B
backing up

hard drive
Windows Vista B–3
Windows XP C–4

specific files or folders
Windows Vista B–3
Windows XP C–4

system modifications C–6
the system C–3

backup C–2
Backup and Recovery

Windows Vista B–1
Windows XP C–1

backup suggestions B–2
base enclosure, spare part 

number 3–9, 3–27
battery

removal 5–6
spare part numbers 3–11, 

3–26, 5–6
battery bay 1–13, 1–22
battery light 1–7
battery release latch 1–22
Bluetooth module

removal 5–12
spare part number 3–15, 

3–25, 5–12
Bluetooth module cable

illustrated 3–19
removal 5–71

Bluetooth module cover
illustrated 3–18
removal 5–12

bottom components 1–22
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Index
C
Cable Kit

contents 3–19
spare part number 3–5, 

3–19, 3–27
cables, service considerations 

4–2
caps lock key 1–15
caps lock light 1–19
carrying case, spare part 

number 3–21, 3–23
CMOS clearing 1–4
components

bottom 1–22
front 1–6
keyboard 1–12, 1–14
left-side 1–10
rear 1–10
right-side 1–8
top 1–16, 1–18, 1–20

computer feet
illustrated 3–18
locations 5–11

Computer Setup
Advanced Menu 2–7
Diagnostics Menu 2–7
File menu 2–4
menus 2–4
overview 2–1
Security Menu 2–5

computer specifications 6–1
connector pin assignments

audio-in E–2
audio-out E–1
external monitor E–4
headphone E–1

microphone E–2
modem E–5
monitor E–4
network E–6
RJ-11 E–5
RJ-45 E–6
S-Video-out E–3
Universal Serial Bus (USB) 

E–2
connectors, service 

considerations 4–2
creating recovery points B–4

D
design overview 1–24
Digital Media Slot 1–7
disassembly sequence chart 

5–3
diskette drive

OS loading problems 2–23
precautions 4–3
spare part number 3–23

display assembly
removal 5–44
spare part numbers 3–3, 

3–28, 5–44
display bezel

illustrated 3–16
removal 5–50
spare part number 3–17, 

3–27, 5–48, 5–50
Display Bracket Kit, spare part 

number 3–17, 3–28, 5–48
Display Cable Kit, spare part 

number 3–17, 3–28, 5–48
Index�2 Maintenance and Service Guide



Index
display component recycling 
D–1

display enclosure
illustrated 3–16
spare part number 3–17, 

3–28, 5–48, 5–50
display hinge

illustrated 3–16
removal 5–51

Display Hinge Kit, spare part 
number 3–17, 3–28, 5–48, 
5–51

display inverter
illustrated 3–16
removal 5–53
spare part number 3–17, 

3–27, 5–48, 5–53
display panel

illustrated 3–16
removal 5–52
spare part numbers 3–17, 

3–27, 3–28, 5–48, 5–52
display release button 1–7
Display Rubber Kit, spare part 

number 3–28
Display Screw Kit, spare part 

number 3–17, 3–28, 5–48
docking connector 1–22
drive light 1–7
drives, preventing damage 4–3
DVD/CD-RW Combo Drive

spare part number 3–26
DVD±RW and CD-RW 

Combo Drive
precautions 4–3
removal 5–21

spare part number 3–11, 
3–20, 3–26, 5–21

specifications 6–6, 6–8
DVD-ROM drive

precautions 4–3
removal 5–21
spare part number 3–11, 

3–20, 3–21, 3–26, 5–21
specifications 6–8

E
electrostatic discharge 4–4, 

4–8
exhaust vents 1–11
expansion product

spare part number 3–21
troubleshooting 2–18

external monitor port
location 1–13
pin assignments E–4

External MultiBay II power 
cable and stand, spare part 
number 3–21, 3–23

External MultiBay II, spare 
part number 3–21, 3–23

F
f1 to f12 keys 1–15
fan assembly

removal 5–38
spare part number 3–7, 

3–27, 5–38
features 1–2
feet

illustrated 3–18
locations 5–11

fingerprint reader 1–19
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Index
fingerprint reader insert, spare 
part numbers 3–21, 3–31

flowcharts, troubleshooting
no audio 2–25, 2–26
no network/modem 

connection 2–30
no OS loading 2–19
no OS loading from 

diskette drive 2–23
no OS loading from hard 

drive 2–20, 2–21, 2–22
no OS loading from optical 

drive 2–24
no power 2–12, 2–14, 2–15
no video 2–16, 2–17
nonfunctioning device 

2–27
nonfunctioning docking 

device 2–18
nonfunctioning keyboard 

2–28
nonfunctioning pointing 

device 2–29
fn key 1–15
front components 1–6

G
grounding equipment and 

methods 4–7

H
hard drive

OS loading problems 2–20
precautions 4–3
removal 5–7

spare part numbers 3–9, 
3–20, 3–26, 3–30, 3–31, 
5–7

specifications 6–4
hard drive bay 1–23
hard drive cover

illustrated 3–18
removal 5–8

headphone jack
location 1–11
pin assignments E–1

heat sink
removal 5–39
spare part numbers 3–7, 

3–27, 3–30, 3–31, 5–39
HP Docking Station, spare part 

number 3–21, 3–23
HP Extended Life Battery, 

spare part number 3–21, 
3–23

I
I/O address specifications 

6–12
Info Center button 1–17
infrared port 1–7
initiating a Recovery

from the hard drive 
Recovery Partition

Windows Vista B–7
in Windows Vista B–6

interrupt specifications 6–10
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K
keyboard

removal 5–23
spare part numbers 3–3, 

3–28, 3–29, 3–30, 5–23
troubleshooting 2–28

keyboard components 1–12, 
1–14

keypad 1–15

L
Label Kit, spare part number 

3–21, 3–27
LED board, spare part number 

3–9, 3–28
left-side components 1–10

M
mass storage devices, spare 

part numbers 3–20
memory map specifications 

6–15
memory module

removal 5–14, 5–29
spare part numbers 3–5, 

3–25, 3–26, 5–14, 5–29
memory module compartment 

1–23
memory module compartment 

cover
illustrated 3–18
removal 5–15

microphone
removal 5–66, 5–67
spare part number 3–5, 

3–28, 5–66

microphone jack
location 1–11
pin assignments E–2

Mini Card compartment 1–23
Mini Card module 

compartment cover
illustrated 3–18
removal 5–19

Mini Card WLAN module
removal 5–17
spare part numbers 3–11, 

3–13, 3–15, 3–24, 3–25, 
5–17

Mini Card WWAN module
removal 5–33
spare part number 3–7, 

3–26, 5–33
spare part numbers 3–30

Miscellaneous Plastics Kit (for 
use with docking device), 
spare part number 3–21, 
3–23

modem jack
location 1–9
pin assignments E–5

modem module
spare part number 3–5, 

3–25, 5–31
troubleshooting 2–30

modem module cable
illustrated 3–19
removal 5–72

monitor port
location 1–13
pin assignments E–4
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MultiBay II device 1–9
removal 5–21
spare part numbers 5–21

MultiBay II eject assembly
removal 5–77
spare part number 3–9, 

3–28, 5–77

N
network jack

location 1–9
pin assignments E–6

network, troubleshooting 2–30
nonfunctioning device, 

troubleshooting 2–18, 2–27
num lock key 1–15
num lock light 1–19

O
optical drive

OS loading problems 2–24
precautions 4–3
removal 5–21
spare part numbers 3–11, 

3–20, 3–21, 5–21
specifications 6–6, 6–8

P
packing precautions 4–5
password clearing 1–4
PC Card slot bezel, illustrated 

3–18
PC Card slots 1–11
PC Card/digital media board

removal 5–61
spare part number 3–5, 

3–27, 5–61

performing a Recovery
from hard drive

Windows Vista B–6
from Recovery Discs

Windows Vista B–6
plastic parts 4–2
Plastics Kit

contents 3–18
spare part number 3–5, 

3–18, 3–27
pointing device, 

troubleshooting 2–29
pointing stick 1–21
pointing stick buttons 1–21
pointing stick cable, illustrated 

3–19
power button 1–17
power button board

removal 5–37
spare part number 3–3, 

3–28, 5–37
power connector 1–13
power cord

set requirements F–2
spare part numbers 3–22, 

3–23
power light 1–6, 1–19
power management features 

1–5
power, troubleshooting 2–12
presentation button 1–17
processor

removal 5–42
spare part numbers 3–9, 

3–26, 3–27, 3–30, 3–31, 
5–42
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R
rear components 1–10
Recovery

Windows Vista B–5
removal/replacement

preliminaries 4–1
procedures 5–1

right-side components 1–8
RJ-11 jack

location 1–9
pin assignments E–5

RJ-45 jack
location 1–9
pin assignments E–6

RTC battery
removal 5–28
spare part number 3–5, 

3–27

S
safeguarding your data C–2
scheduling backups

Windows Vista B–5
Screw Kit

contents A–1
spare part number 3–22, 

3–27, A–1
screw listing A–1
security cable slot 1–13
serial number 1–23, 3–1, 5–2
service considerations 4–2
smart card slot 1–9

speaker
location 1–7
removal 5–64
spare part number 3–9, 

3–27, 5–64
specifications

computer 6–1
DVD±RW and CD-RW 

Combo Drive 6–6, 6–8
DVD-ROM drive 6–8
hard drive 6–4
I/O addresses 6–12
interrupts 6–10
memory map 6–15
optical drive 6–6, 6–8
system DMA 6–9

static shielding materials 4–8
stringent security 1–4
S-Video-out jack

location 1–13
pin assignments E–3

switch cover
removal 5–35
spare part number 3–3, 

3–28, 5–35
system board

removal 5–68
spare part numbers 3–7, 

3–28, 3–30, 5–68
system DMA 6–9
system memory map 6–15
Maintenance and Service Guide Index�7



Index
T
thermal pads, replacing 5–41
thermal paste, replacing 5–41
tools required 4–1
top components 1–16, 1–18, 

1–20
top cover

removal 5–55
spare part number 3–5, 

3–27, 3–30, 5–55
TouchPad 1–21
TouchPad cable, illustrated 

3–19
TouchPad left/right buttons 

1–21
TouchPad scroll zone 1–21
transporting precautions 4–5
troubleshooting

audio 2–25
expansion product 2–18
flowcharts 2–10
keyboard 2–28
modem 2–30
network 2–30
nonfunctioning device 

2–18, 2–27
OS loading 2–19
overview 2–1
pointing device 2–29
power 2–12
video 2–16

U
Universal Serial Bus (USB) 

diskette drive, spare part 
number 3–21

Universal Serial Bus (USB) 
port

location 1–9, 1–11
pin assignments E–2

unknown password 1–4

V
vents 1–23
video troubleshooting 2–16
volume buttons 1–17

W
when to back up B–1
Windows applications key 

1–15
Windows logo key 1–15
wireless antenna

illustrated 3–16
removal 5–54

Wireless Antenna Kit, spare 
part number 3–17, 3–28, 
5–48, 5–54

wireless button 1–17
wireless light 1–6, 1–17, 1–19
workstation precautions 4–6
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